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Introduction

The Meridian 561 Digital Surround Controller combines a completely digital

surround-sound processor with a high-performance digital preamplifier and

a video controller in a single integrated unit. Its unique combination of

features allows you to build a complete system for audio and video

reproduction with a minimum of additional components. The result is an

impressively realistic and exciting reproduction of music and cinema sound.

The 561 Digital Surround Controller accepts analogue, digital, composite

video, and S-video sources. It supports all the current two-channel and

multi-channel audio formats including PCM, Dolby Digital (AC-3), DTS, and

MPEG. It also includes several proprietary processing modes, including the

MLP (Meridian Lossless Packing) format.

For instructions on setting up the unit turn to Setting up the digital

surround controller, page 49. Once the digital surround controller has been

set up refer to the next chapter, Using the digital surround controller, for

information about getting the best results from all your music and film

recordings.
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The 561 Digital Surround Controller is part of the Meridian 500

Series of advanced digital, analogue, and video components

designed to meet the demand for absolute quality, ease of use,

and lasting value.

The flexibility of the Meridian 500 Series is such that you can

assemble a system as simple or as complex as you need,

perfectly suited to your requirements, and allowing you to add to

it or alter it at a later date should your requirements change.

Each Meridian 500 Series component is housed in a matching

slimline case. Front-panel controls provide access to the most

important functions, and the full range of functions is available

from the Meridian System Remote using a simple and intuitive

control interface.

500 Series communications

The Meridian 500 Series includes a sophisticated

communications link, to ensure that any configuration of units

will work together as a fully integrated system.

The 500 Series communications system allows you to control

any combination of units using a single remote, and ensures that

your commands from the remote are interpreted unambiguously.

The communications system also allows you to extend your hi-fi

system into two or three rooms, with the ability to control the

sources in one room from the controller in another room.

Professional features

The 500 Series also includes features for professional users,

including RS232 computer control and balanced connections.

The following pages show two recommended configurations

based on the 561 Digital Surround Controller to illustrate the

flexibility of the Meridian 500 Series.

The Meridian 500 Series
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Meridian Analogue Theatre™

The Meridian 561 Digital Surround Controller is ideal for use with

the M33 Active Analogue Loudspeaker and M1500 Active

Subwoofer. The M33 provides an unusually good response for

such a compact case, and can be mounted either horizontally or

vertically for total flexibility.

Sample configurations

Meridian DVD Player

M33

561

M33M33
M1500

M33 rear M33 rear

The 561 Digital Surround Controller can connect directly to up to

six Meridian active loudspeakers, allowing you to create a 5.1

analogue theatre ideal for superb music and cinema sound in

the home.
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Meridian Digital Theatre™

Meridian DVD Player

DSP5000C

508.24

LaserDisc

Video recorder

M33 side

DSP5000DSP5000

M33 side

561

M33 rear M33 rear

The 561 Digital Surround Controller can be used with two

Meridian DSP5000 Digital Loudspeakers, and a DSP5000C

Digital Centre Loudspeaker, to provide audiophile-quality sound.

A further two or four M33 Active Analogue Loudspeakers can be

added as side or rear loudspeakers to give extremely convincing

multi-channel reproduction from music and film sources.

The Meridian DVD Player is an ideal source for use with the 561.

It allows you to play both audio CDs and DVD video discs,

taking full advantage of the 561’s control and digital signal

processing capabilities.
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Specification

Digital inputs 5 x cable, 75Ω, IEC958 and data

compatible, up to 24 bits.

1 x optical, Toslink (EIAJ), IEC958 and

data compatible, up to 24 bits.

Analogue inputs 7 x unbalanced, 0.7 to 2V sensitivity,

20kΩ input impedance.

1 x stereo 20-bit Delta-Sigma ADC.

Processing 2 x Motorola 56002 running at 66MHz.

1 x Motorola 56303 running at 72MHz.

Internal precision maintained using 24-

and 48-bit arithmetic.

Analogue outputs 3 x stereo 20-bit Delta-Sigma DAC.

6 x unbalanced outputs for centre, sub,

rears, and mains or sides or subs.

Outputs variable between 0 and

3.5Vrms, output impedance 47Ω.

Distortion <0.01%.

Noise and hum <-95dB CCIR.

Digital outputs 4 x stereo SPDIF on cable, 75Ω, up to

24-bit precision.

Video switching 4 x composite inputs.

1 x main composite output with

on-screen display.

1 x tape/second room composite

output.

4 x S-video inputs.

1 x main S-video output with on-screen

display and S-video to composite

conversion.

1 x tape/second room S-video output.

Composite video:  phono, 75Ω,

1.5V p-p, PAL/NTSC/SECAM.

S-video: Y/C on minidin, 75Ω,

1.5V p-p, PAL/NTSC/SECAM.

Specification and accessories
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Tape outputs 2 x stereo analogue for tape and

second zone, 470Ω output impedance.

With additional module: independent

ADC and DAC for analogue and digital

tape loop, variable analogue tape out.

Headphone output only available with

Tape card fitted – full volume control

and headphone amplifier.

Control 2 x Meridian Comms.

9 pin D connector for RS232 PC Setup

and Control.

2 x triggers, active high, 9V up to

100 mA on 3.5mm DC jack.

Dimensions 321mm x 88mm x 332mm

(12.7" x 3.5" x 13.1") (W x H x D).

Weight 5kg (10lb).

Meridian Audio reserves the right to amend product

specifications at any time.

Available accessories

The following accessories are available from your dealer.

Meridian 511 S-patch Box

The Meridian 511 S-patch box provides a convenient way to

interconnect the S leads between up to eight Meridian DSP

digital loudspeakers. It is required if your 561 system includes

more than two DSP loudspeakers.

Expansion cards

A range of expansion cards will be available for the 561 to

extend its capabilities or add features.

The first of these is a Tape card, which provides conversion

between analogue and digital sources, so that analogue

recordings can be made of digital sources, and vice versa. The

Tape card also adds a headphone output to the back panel, with

independent control over the headphone volume.
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Meridian 519 Demodulator

To take advantage of Dolby Digital on LaserDisc you need the

Meridian 519 Demodulator, which converts the LaserDisc

RF output to a bitstream which can be fed to the 561. The

519 Demodulator automatically senses the presence of a Dolby

Digital signal, and can select the LaserDisc PCM or DTS digital

audio output when no Dolby Digital signal is available.

Fan kit

A Fan kit is available for the 561 to provide additional ventilation

if the unit is installed in an enclosed space.

The fan can be programmed using the Meridian Configuration

program so that it either runs when the 561 is out of standby, or

when the temperature rises above the recommended level.

Rack mount kit

The Meridian 500 Shelf is a tray produced by Middle Atlantic

Products which will allow the 561, or any other 500 Series unit,

to be fitted in a standard 19" rack. For more information please

contact Middle Atlantic Products, Inc., Riverdale, NJ 07457,

USA, (001) 973-839-1011, or their local distributor.
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The digital surround controller provides an extremely

comprehensive range of digital signal processing options for

decoding both analogue and digital audio signals and

processing them for multi-channel reproduction. These are

referred to as DSP presets, and are designed to provide the best

results with a range of different types of music and film material.

In addition to selecting built-in DSP presets, the digital surround

controller allows you to create your own presets based on the

standard ones. For example, you may want to add more delay to

the rear speakers to create a more spacious sound. You can

store your modified preset with a name of your choice, and

recall it for use at a later date.

This section gives information about each of the built-in DSP

presets, and gives recommendations for the best preset to

choose for different types of material.

Multi-channel digital sources

The 561 Digital Surround Controller supports the three

alternative multi-channel digital formats currently available,

which encode up to 8 different channels onto a digital signal:

Dolby Digital (AC-3), DTS, and MPEG Audio. It also supports

Meridian’s own MLP format.

Dolby Digital

Dolby Digital, previously called AC-3, is the preferred sound

format for DVD video, and is widely used on LaserDisc

soundtracks. It is also the audio standard for US digital

television.

DTS

DTS uses a carefully designed audio compression technique to

encode five channels of audio onto a digital signal. The DTS

format is used to encode multi-channel film soundtracks on

LaserDiscs and DVD video discs.

DSP presets
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In addition, a high data-rate version of DTS can be used to

compress five channels of CD-quality audio into the same space

as two channels of unencoded sound, allowing a DTS music CD

to provide over an hour of five-channel music, at a quality

indistinguishable from conventional CD.

MPEG Surround

MPEG Surround is the preferred audio format for DVD in PAL

territories, and along with Dolby Digital is a contender as the

standard for music and performance videos on DVD worldwide.

In addition, it is widely available in US satellite broadcasts.

THX

THX versions of Dolby Digital, MPEG Surround, and DTS are

provided to give a better match between the original soundtrack

and typical domestic listening conditions.

MLP

MLP (Meridian Lossless Packing) is a format designed for DVD

audio which allows multiple audio channels, of up to 192kHz

24-bit quality, to be stored on a DVD without losing any

information. It can also be used to store four-channel audio on a

standard CD without any loss of quality.

Multi-channel sources encoded onto
two channels

Several systems have been developed for encoding multi-

channel sources onto a standard two-channel analogue signal

so that they can be reproduced by a conventional stereo

system, or decoded with special equipment for multi-channel

reproduction. The 561 Digital Surround Controller provides

decoding of the two most important of these, Ambisonic and

Dolby Surround. Although the channel separation cannot be as

good as with the digital multi-channel formats, the 561 produces

excellent results with these formats.

Pro Logic

The Pro Logic preset is recommended for decoding Dolby

Surround encoded video and LaserDisc soundtracks, and films

on television. Such materials are usually identified by a Dolby

Surround symbol on the packaging, or displayed on the film

before the programme.
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TV Logic

TV Logic provides user-adjustable steering, and is

recommended for use with TV broadcasts that are not surround

encoded, where Pro Logic may give reduced intelligibility.

THX Cinema

THX Cinema enhances Pro Logic to replicate the sound of a

dubbing stage or theatre, whether or not the other equipment in

your system is THX approved.

Ambisonic

Ambisonic decodes material specifically encoded for surround

sound reproduction, using a two-channel stereo-compatible

encoding. Recordings encoded in Ambisonic format are

available on CD from several sources including Nimbus Records

and York Ambisonic. Some radio broadcasts are also broadcast

in Ambisonic format.

Conventional stereo sources

The digital surround controller can also accept a conventional

two-channel source, such as music on compact disc or a video

soundtrack, and by analysing the information in the signal

separate the two-channel recording into multiple channels to

give better reproduction and a more stable spatial image.

Four alternative DSP presets are provided for reproducing

material originally designed for a conventional stereo pair of

speakers, and which preset you choose largely depends on your

own personal preferences.

All four presets use similar procedures to extract the surround

component of the original recording, which is delivered to the

rear surround speakers, and side surround speakers if present.

Music

Music uses a special technique developed by Meridian to divide

the sound between the left, right, and centre speakers and give

a wide, spacious sound. We recommend this option for large-

scale music, such as orchestral and choral music.
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Trifield

Trifield uses a different processing technique to give a stable,

three-dimensional image, with the ability to adjust the width of

the image. Because of its precision we recommend this option

for solo, chamber, or vocal music.

Super Stereo

Super Stereo provides a form of Ambisonic decoding suitable

for material that is not specially encoded. We recommend this

option for multi-miked or multi-tracked music, such as rock

music.

Music Logic

Music Logic provides user-adjustable steering to give an

exciting sound with many types of music. We recommend this

option for studio-produced music, ie material not produced

using natural soundfield recording.

Special DSP presets

The digital surround controller also includes the following special

DSP presets, for specific applications:

Mono and Academy

The Mono and Academy presets are designed for reproducing

mono materials through a centre speaker, so that any high-

frequency hiss or clicks are centrally localised.

Mono is designed for mono recordings, and multi-language

LaserDiscs and video soundtracks.

Academy is designed for early black and white film

soundtracks. It includes equalisation designed to correct for a

high-frequency balance in some old black and white films.

Stereo and Direct

Stereo and Direct are provided for comparison with the other

DSP presets. Direct uses just the main left and right speakers

for traditional two-speaker stereo reproduction. Stereo, in

addition, uses any subwoofers in the layout to enhance the bass

or to protect small speakers.
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Using the digital
surround controller

This chapter provides a summary of the functions of the digital surround

controller to identify the controls which you use to operate the unit.

It also provides step-by-step instructions for operating the digital surround

controller, using either the front panel or the Meridian System Remote.
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Front panel

1 Source

Selects the source.

2 Copy

Copies a selected source to

the tape and VCR outputs.

3 Preset

Changes the preset.

4 Mute

5 Display

Changes the information

displayed on the front panel.

6 V Decrease

Decreases the volume.

7 A Increase

Increases the volume.

8 Off

Switches to standby.

CopySource VPreset Mute A Off

Digital   65
BOOTHROYD STUART

561
Digital Surround Controller Display

2 3 4 5 6 7 8

Display

1
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1 Source keys

Select a source.

2 Control keys

Control the source functions.

3 Off

Switches to standby.

4 Function

Acesses additional functions.

5 Number keys

For entering track numbers

and radio presets.

6 Title/Chapter

For controlling a DVD Player.

7 Menu keys

For customising the 561.

8 Preset

Changes the DSP preset.

9 Display

Changes the front-panel

display.

10 Volume keys/Mute

Change the volume.

Meridian System Remote

Subtitle

Off

EnterReturn

Function 0 Title

Chapter

Record

Slow

OSD

T

Angle Audio A-B Phase

Setup

Band

7 8 9

4 5 6

1 2 3

Menu Volume

Display MutePreset

Clear

Store

Repeat

CD RADIO LP TV TAPE 1 TAPE 2 CDR CABLE DVD VCR 1 VCR 2 LD

4

1 2 3

5 6 7 8 9 10
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Quick guide to operating the 561 with the remote

Action 561 as controller DSP speaker as controller

Source selection CD, RADIO etc. CD, RADIO etc.

Go to standby Off Off

Volume Volume A V Volume A V

Mute Mute Mute

Headphone volume (with Tape card only) Function + Volume A V Function + Volume A V

Change display Display Not available

Change DSP preset Preset Preset

Move to next or previous menu Menu < > Function + Menu < >

Change the value of this menu Menu A V Function + Menu A V

Store settings as a new DSP preset Store Function + Store

or over an existing one

Associate the current DSP preset Function + Store Function + Mute

with the current source

Delete an unwanted user preset Clear (held down) Function + Clear (held down)
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When not playing, the digital surround controller should be left in

the standby state. This uses a negligible amount of electricity,

but ensures that the components of the digital surround

controller operate at maximum efficiency from the moment you

start.

If you are not going to use the digital surround controller for

several days you should switch the unit completely off at the

back panel, and disconnect it from the AC power supply.

To switch on from standby

● Press Source (front panel), or select a source by pressing the

appropriate source key on the remote; eg DVD.

If the digital surround controller is part of a Meridian system it

will automatically switch on any other unit in the system, such as

the CD player and Meridian DSP loudspeakers.

To select a source

● Press Source (front panel) until the display shows the source

you require.

For example:
  DVD       

Alternatively press the appropriate source key on the remote;

eg DVD.

After a short delay the display shows the currently selected DSP

preset and volume setting.

For example:
Digital   56

The digital surround controller mutes the sound while you

change source.

By default the following 12 sources are available: CD, Radio,

DTV, TV, Tape 1, Tape 2, CDR, Cable, DVD, VCR1, VCR2, and

LDisc.

Selecting a source
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The audio input, video input, and DSP preset associated with

each source can be configured using the Meridian Configuration

program; for more information refer to Configuring the digital

surround controller using a computer, page 79.

To switch to standby

● Press Off on the front panel or the remote.

The display will show:
        .

If you have other Meridian 500 Series equipment or Meridian

DSP loudspeakers connected to the digital surround controller

these units will also switch to standby.
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To mute the sound

● Press Mute.

The display will show:
Mute

To restore the sound

● Press Mute again.

Alternatively, the sound will be restored if you adjust the volume.

The digital surround controller adjusts the volume in precise

steps of 1dB, where 9dB is equivalent to doubling the loudness.

The current volume setting is displayed in dB on the front panel

display, and can be varied in the range 1 to 99dB.

When you first connect power to the digital surround controller

the volume is set to 65, which is similar to the midway position

of the rotary volume control on a conventional preamplifier.

A setting of 87 corresponds to THX reference gain, the level at

which film soundtracks are mixed. For normal to high-level

listening you should expect to use volume levels in the range 60

to 90.

To change the volume

● Press A or V (front panel), or the red A or V keys on the

remote.

As you adjust the volume setting the display will show the

current volume level.

For example:
Music     70

Adjusting the volume
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Each source has a set of DSP presets associated with it, one for

each of the alternative audio formats: two-channel (PCM), Dolby

Digital, DTS, MPEG, and MLP.

When you choose a source an appropriate DSP preset is

selected for the incoming audio format.

For example, if you have selected the CD source and are playing

a conventional CD, the Trifield DSP preset will initially be

selected. You may then wish to choose a different DSP preset,

such as Music or Ambisonic.

You can also change the default DSP preset associated with the

source; see Changing the DSP preset for a source, page 33.

To change the DSP preset

● Press Preset (front panel or remote) to step between the

different DSP presets.

The display shows the current preset;

for example:
Music

You will be able to choose any of the predefined DSP presets, or

any user-defined presets you have stored.

Changing the DSP preset

The following table gives the sequence of DSP presets for each

audio format, followed where appropriate by the abbreviated

name used on the display:

Audio format Presets

Two-channel (PCM) Direct, Music, Trifield, Ambisonic

(Ambsonic), Super Stereo (Super),

Stereo, Music Logic (MuLogic),

Pro Logic (ProLogic), THX Cinema

(THX), Mono, Academy, TV␣ Logic

Dolby Digital Dolby Digital (Digital),

Dolby Digital THX (Dig THX)

DTS DTS, DTS THX, DTS Music (DTS Mus)

MPEG MPEG, MPEG THX,

MPEG Music (MPEG Mus)

MLP MLP

In each case these will be followed by any user-defined presets

you have stored for the appropriate audio format.
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Changing the display

The digital surround controller displays information about the

current settings on the twelve-character front panel display. In

addition, it can display the same information superimposed on a

video image. For more information about setting up the on-

screen display refer to Connecting video, page 56.

To change the display

● Press Display.

Each time you press Display the display will step between the

options shown in the table opposite.

In addition, the following symbols on the front panel display

indicate which of the DSP processing modes are operating:

Symbol What it means

THX processing is operating.

Dolby processing is operating.

Input is DTS.

MPEG Input is MPEG.

Display option Example

DSP preset and volume
Music     65

DSP preset and THX gain
Music    -22

Source and volume
Radio     65

Audio stream
AC3 3/2.1 44

Blank



The audio stream display option shows the following three

pieces of information about the audio stream:

AC3 3/2.1 44

Sample rate:
44 44kHz
48 48kHz
32 32kHz
NL Not locked

Format:
PCM 2-channel PCM
AC3 Dolby Digital
DTS DTS encoding
MPG MPEG encoding
MLP MLP encoding

Input channels:
Front/Rear.LFE
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The 561 Digital Surround Controller allows you to copy any of

the standard sources to the tape and VCR outputs,

independently of the source you are listening to.

If you are using the digital surround controller in a two-room

system, you copy a source to the tape output to make it

available to the second room.

To copy a source

● Press Copy.

Each time you press Copy the digital surround controller will

step between the options shown in the table opposite.

For example, to record the television picture and sound on a

VCR:

● Press Copy until the display shows:
Copy TV 


You can now listen to a different source, such as CD, by

selecting the source, without affecting what is being recorded.

Recording a source

Display Option

Copy Source
The current audio and video inputs

are fed to the tape/VCR outputs.

Copy Mute
The tape and VCR outputs are

muted.

Copy CD
Copies the first source to the tape

and VCR outputs.

Copy Radio
Steps through each source in turn,

etc.

To change the headphone volume

You can connect headphones to the 561 using the optional

Tape expansion card. The source copied to the tape output is

also fed to the headphones.

To change the headphone volume:

● Press Function with the red A or V keys on the remote.

The display will show the current

headphone volume; for example:
Headphone 65
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Defining your own
presets

In addition to being able to change the source, volume, and DSP preset,

the digital surround controller provides a sophisticated range of more

advanced adjustments for each DSP preset, to allow you to change the

characteristics of the sound to the settings you want.

This chapter explains how to change these advanced parameters, and

how to store them permanently so they are available whenever you want

to use them.

For information about the parameters specific to individual presets see

DSP presets, page 37.
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Locking and unlocking the menus

To simplify the normal operation of the digital surround

controller, and to protect the settings from accidental changes,

you can lock the menus so that the parameters cannot be

accessed.

To display or change the DSP presets, or to define your own

presets, you first need to unlock the digital surround controller

menus.

To lock the menus

● Press Off to put the 561 in standby.

The display shows:
        .

● Press and hold down Preset for a

few seconds until the display shows:
Locked

To unlock the menus

● Repeat the above sequence so

that the display shows:
Unlocked
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Changing the DSP parameters

Each DSP preset provides a series of parameters that you can

vary to customise its behaviour to your specific requirements.

For example, most presets provide Balance and Depth

parameters which alter the characteristics of the sound.

For each of the built-in DSP presets these parameters are set to

standard values, designed to give the best sound in typical

listening conditions and with most source materials. Each time

you select a different DSP preset the parameters are reset to

these standard values, even if you have previously altered them.

You can save the changes you have made to one or more DSP

parameters in place of the original DSP preset. Alternatively you

can create a new user-defined DSP preset, with a name of your

choice. User-defined presets appear in the list of DSP presets

after the built-in ones. See Defining your own presets, page 34.

Standard parameters

All DSP presets (except Mono and Direct) provide the standard

parameters shown on the next page.

Individual DSP presets provide additional parameters, to allow

you to adjust specific features provided by that preset. For full

details refer to DSP presets, page 37.

To change a DSP parameter

● Make sure the menus are unlocked; see To unlock the menus

opposite.

● Press > or < (remote) until the display shows the name of the

parameter you want to change.

For example:
Treble  +1.5

● Press A or V (remote) to change the value of the parameter.

As you change the value you will be able to hear the effect on

the sound, and the display will show the current value.

After a short delay the display will revert to the normal display of

DSP preset and volume.

Using a Meridian DSP loudspeaker

If you are using a Meridian DSP loudspeaker as the controller for

your system, select the parameter you want to change by

pressing Function > or Function < on the remote, and change

the parameter by pressing Function A or Function V on the

remote.
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Parameter Range Default What it changes

Treble * † -10dB to +10dB +0dB The slope of the frequency response.

Bass * † -5dB to +5dB +0dB The bass response.

Phase * † + or - + The phase of all loudspeakers.

Balance <10 to 10> <0> The L-R balance.

Centre -3.0dB to +3.0dB +0.0dB The level of the centre.

Depth -2.5ms to +5.0ms +0.0 The delay of the centre.

Rear -30dB to +10dB +0dB The level of the rears.

Sides -30dB to +10dB +0dB The level of the sides.

R Delay ‡ 0ms to 30ms 15.0ms The delay of the rears.

S Delay ‡ 0ms to 30ms 15.0ms The delay of the sides.

LipSync 0ms to 30ms 0ms The sync. delay.

OSD * Off, Low, Med, High Low The position of the on-screen display.

* These parameters apply to all DSP presets.

† These parameters appear on the speakers if you are using DSP loudspeakers.

‡ These parameters have a range of 0 to 15ms for 5.1 Movie presets and a range of 15ms to 30ms for Logic presets.

Standard parameters
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The digital surround controller provides sophisticated treble and

bass controls, to allow you to adjust the broad balance of the

system to correct for the acoustics of your listening room, or for

a misbalanced recording.

The controls are more subtle than conventional tone controls,

and take advantage of digital signal processing techniques to

provide a more natural adjustment of the frequency response.

You can also change the absolute phase of the signal, to

compensate for recordings which are out of phase.

In each case all the outputs of the digital surround controller are

given the same adjustment, to ensure a correct surround effect.

If you have a Meridian DSP loudspeaker these menus appear on

the speaker. For more information see the speaker user guide.

To change the treble

● Press > or < (remote) until the

display shows the current treble.

For example:
Treble  +1.5

● Press A or V (remote) to change the treble.

The treble control tilts the frequency of the response over the

entire frequency range to make the sound brighter or dimmer. It

can be adjusted between ±10dB in 0.5dB steps. Normally

settings between +1.0 and -2.0 will give the most natural results.

To change the bass

● Press > or < (remote) until the display shows the current bass

setting.

For example:
Bass    +0.5

The bass control allows you to adjust the bass response in the

room by ±5dB in 0.5dB steps. Normally settings between +3.0

and -2.0 will give the most natural results.

● Press A or V (remote) to change the bass.

To change the absolute phase

● Press > or < (remote) until the display

shows the phase; for example:
Phase      +

● Press A or V (remote) to change the phase.

Changing treble, bass, or phase
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To move the listening position to the
left or right

● Press > or < (remote) until the display shows the current

balance.

For example:
Balance  <0>

● Press A or V (remote) to move the listening position.

The display shows the direction and position of the listening

position.

For example:
Balance   <8

The arrow indicates the direction, and the number indicates the

position where 0 is central, 8 is in line with the corresponding

main speaker, and 10 is fully to one side.

Note that this adjustment is not available for the Mono or

Academy presets.

A conventional stereo system provides a single balance control,

which changes the relative loudness of the two speakers. The

561 Digital Surround Controller provides a more sophisticated

adjustment which corresponds to moving the listening position

to the left or right.

You can also change the level of the rear or side loudspeakers

relative to the main speakers.

Changing the listening position
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To change the relative level of the rear
or side loudspeakers

● Press > or < (remote) until the display shows the speaker(s)

you want to adjust.

For example:
Rear      +0

● Press A or V (remote) to change the relative level of the

speakers, in dB.

You can change the relative loudness of the rear loudspeakers

from -30dB (about one-eighth of the loudness) to +10dB (about

double the loudness).

For example, to double the loudness of the loudspeakers:

● Adjust their level until

the display shows:
Rear     +10

Note that this adjustment is not available for the Direct, Stereo,

Mono, or Academy presets.

If you have side speakers an additional Sides parameter allows

you to adjust the relative loudness of the side speakers.
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Changing the integration of the centre

To change the relative delay of the
centre speaker

● Press > or < (remote) until the display shows the current

centre depth.

For example:
Depth   +0.0

● Press A or V (remote) to change the relative depth of the

centre speaker.

You can change the depth between -2.5ms, which corresponds

to moving the centre speaker 2 Qw  feet nearer to the listening

position, and +5ms, which corresponds to moving it 5 feet

further away from the listening position.

If you have a centre loudspeaker you can adjust its relative

loudness, to provide the best integration of the centre with the

main left and right speakers.

You can also adjust the relative delay of the centre speaker to

give the best perspective between the three front speakers.

Note that these adjustments are not available for the Direct,

Stereo, Mono, or Academy presets.

To change the relative level of the
centre speaker

● Press > or < (remote) until the display shows the current

centre level.

For example:
Centre+0.0dB


● Press A or V (remote) to change the relative level of the

centre speaker.

You can change the relative level by ±3dB in 0.5dB steps.
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Changing the spaciousness of the sound

If you have side speakers an additional S Delay option allows

you to adjust the delay on the side speakers between 15ms and

30ms. Note that for best results you should never set the

S Delay to be less than the R Delay.

You can adjust the spaciousness of the sound by altering the

delay on the rear and side channels.

Note that these adjustments are not available for the Direct,

Stereo, Mono, or Academy presets.

To change the relative delay of the
rear or side speakers

● Press > or < (remote) until the display shows the speaker(s)

you want to adjust.

For example:
R Delay 15.0


● Press A or V (remote) to change the relative delay of the

speakers.

The range of possible values depends on the preset. With the

music presets (Music, Trifield, and Ambisonic) you can change

the rear delay between 0ms and 30ms, which is equivalent to

moving the rear speakers 30 feet away.

The 5.1 Movie presets allow you to vary the delay between 0ms

and 15ms, and the Logic presets allow you to vary it between

15ms and 30ms.
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To adjust the lip sync

The LipSync parameter is a unique feature of the digital

surround controller which allows you to adjust the delay

between the sound and the video image by up to one video

frame.

Most movies are mixed for a viewing distance of 30 feet, and

when viewed from 12 feet or less the sound arrives too early,

giving a disconcerting effect. Using the LipSync parameter you

can add an overall delay to the sound to accommodate your

closer home viewing distance.

Many TV broadcasts delay the picture by half a frame, and can

benefit from a LipSync setting of 12ms.

● Press > or < (remote)

until the display shows:
LipSync    0

● Press A or V (remote) to change the delay in milliseconds.

You can adjust the delay between 0 and 30ms, where 30ms

corresponds to sitting 30 feet further away from the screen.

To change the position of the
on-screen display

For each DSP preset you can specify the position of the

on-screen display (OSD), or blank the on-screen display

altogether.

For example, you may prefer to have the on-screen display at

the top of the screen when watching videos, but at the bottom

of the screen when listening to music.

● Press > or < (remote) until the display shows the current OSD

position.

For example:
OSD      Low

● Press A or V (remote) to change the position.

You can choose between Off, Low, Med, or High.

Changing the lip sync and on-screen display
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Each source has an appropriate DSP preset associated with it

for each music format. For example, for a standard stereo (PCM)

signal the CD source uses Trifield and the TV source uses

TV Logic.

This section explains how to change the DSP preset associated

with any source.

To change the DSP preset for a
source

● Make sure the menus are unlocked; see To unlock the menus,

page 24.

● Select the source you want to change, by pressing the

Source key on the front panel or the appropriate source key

on the remote; eg CD.

● If necessary, select a signal in the appropriate format. For

example, to change the DSP preset used for DTS compact

discs, play a DTS CD.

● Press Preset (front panel or remote) to select the DSP preset

you want to associate with the source.

For example:
  Trifield

● Press Function Store (remote) to save the new association.

If you are using a Meridian DSP loudspeaker press Function

Mute.

The display shows the source and

preset you have stored; for example:
CD=Trifield

After a short delay the display will revert to the normal display of

DSP preset and volume.

Changing the DSP preset for a source
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The 561 Digital Surround Controller allows you to modify one of

the built-in presets, and save it for future use.

You can either save the changes to the built-in preset, or you

can create up to 12 presets of your own, with names of your

choice, so you can use them alongside the built-in presets.

To save the preset settings

● Make sure the menus are unlocked; see To unlock the menus,

page 24.

● If necessary, select a signal in the appropriate format. For

example, to change the DSP preset used for DTS compact

discs, play a DTS CD.

● Press Preset (front panel or remote) to select the DSP preset

you want to modify and then associate with the source.

For example:
  Trifield

● Change the preset parameters to the values you want to

store; see To change a DSP parameter, page 25.

● Press Store (remote).

The display shows the next available user-defined preset.

For example:
Sto.User 2

● If you want to overwrite an existing user-defined preset press

A or V to select the preset you want to overwrite.

For example:
Sto.User 1

Alternatively if you started with a built-in preset you can choose

that and overwrite it.

For example:
Sto.Trifield

● Press Store (remote).

The settings have been stored in the new or existing preset you

selected.

If you are defining a user preset you can now edit the name of

the preset if you wish.

Defining your own presets
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A flashing cursor shows the letter you

are editing:
Sto.•ser 1

If you have an on-screen display it shows:

● Press > or < to select the character position you want to edit.

● Press A or V to change the character.

Each press steps through the sequence A to Z, a to z, 0 to 9, full

stop, and blank. You can also select a blank directly by pressing

Clear (remote).

If you are using a Meridian DSP loudspeaker you select a blank

by pressing Function Clear.

For example, you could change the

name to:
Sto.La Scala

● When you have entered the name you want to use press

Store.

The display shows the source and the new preset you have

defined.

For example:
CD=La Scala
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To clear a user-defined preset

● Make sure the menus are unlocked; see To unlock the menus,

page 24.

● Press Preset (front panel or remote) to select the DSP preset

you want to clear.

For example:
  User 2

● Press and hold down Clear (remote) for several seconds.

The display shows:
Preset Clear

If you clear a preset that was saved over a built-in preset, the

original settings are restored.
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DSP presets

This chapter gives technical information about each of the DSP presets

built in to the digital surround controller.

It explains the processing performed by each DSP preset, and gives

details of the types of material you should use with each preset.

It also gives details of the special DSP parameters available for each

preset.

The DSP presets are divided into three categories: Logic, Music, and 5.1

Movie. You can set up the 561 Digital Surround Controller to use a

different subwoofer configuration for each category of DSP preset.
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Logic DSP presets

The digital surround controller provides five DSP presets

specifically designed for reproducing stereo film soundtracks.

Three of these presets, Pro Logic, THX Cinema, and TV Logic,

are designed for Dolby Surround encoded material. Most films,

and many TV programmes and series, are encoded using Dolby

Surround, and it is increasingly being used to encode music.

The 561 Digital Surround Controller follows the Meridian

philosophy of performing all the signal processing digitally, and

the Dolby Surround decoding operates purely in a digital mode.

This gives it a far higher performance and a better subjective

sound than other analogue-based decoders.

The remaining two Logic presets, Mono and Academy, are

designed for films with mono soundtracks.

Pro Logic

Dolby Surround is an encoding system based on a phase-

amplitude matrix whose output can be decoded by a very

simple passive matrix. Such a decoder gives quite a poor

separation.

The Pro Logic system uses psychoacoustically optimised

directional enhancement to increase the separation in both

left–right and front–back directions. It does this by continuously

calculating the position and degree of the currently dominant

sound. This sound is then steered to a greater or lesser extent to

that position in the arriving sound. This technique is very

successful for cinema and other dramatic programmes.

Further refinements in the Pro Logic decoder include the filtering

and delay of the rear surround signal to reduce any tendency for

the surround signals to divert attention or become dominant.

The Pro Logic decoder also uses a modified digital Dolby noise-

reduction process in the surround signal. Since Dolby Surround

material is encoded with this in mind the noise-reduction is

permanently operating in this mode.
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THX Cinema

The THX Cinema DSP preset provides Pro Logic decoding,

followed by additional signal processing refinements developed

by Lucasfilm Ltd.

The THX extensions to Pro Logic decoding are designed to

provide a better match between the sound of the movie theatre

and a home cinema in the following ways:

❍ The front channels are re-equalised to correct for the higher

treble often found in film soundtracks.

❍ The surround channels are frequency-corrected using a

timbre-matching process so that sounds moving front–back

are more convincing.

❍ The surround channels are decorrelated to break up any

artificial localisation of the rear signals due to the speakers

being nearby. In the 561 Digital Surround Controller this

decorrelation is optimised to give spacious surround sound

that has no artefacts disturbing to music or other sensitive

sounds in the mix.

❍ The time synchronisation between loudspeakers is adjusted to

compensate for the fact that the speakers in a home system

tend to be a lot closer to the listener than in a movie theatre.

THX can also be used with the 5.1 Movie DSP presets; see

Dolby Digital THX, DTS THX, and MPEG THX, page 46.

Pro Logic and THX Cinema DSP
preset parameters

Parameter Options What it changes

Mono Rear Steered Rear, Which of the surround

Steered Side, channels are generated

Steered All, by steering. Mono gives

Mono All, conventional Pro Logic

Mono Rear, surrounds. Steered

Mono Side gives stereo surrounds.

TV Logic

TV Logic is a logic preset, with user-adjustable steering, that

can give higher intelligibility and a more appropriate spatial

presentation for studio-based TV material.



D
S

P
 p

re
s
e

ts

40

TV Logic DSP preset parameters

Parameter Options What it changes

Roll Off, Low, Med, High The degree of

left–right steering.

Yaw Off, Low, Med, High The degree of

front–rear steering.

Mono Rear Steered Rear, Steered Which of the surround

Side, Steered All, channels are

Mono All, Mono generated by steering.

Rear, Mono Side

Mono and Academy

In the Mono and Academy DSP presets you can choose to

listen to:

❍ Only one of two input channels, for use when different

languages or material are carried on each channel.

❍ A combined version of the two input channels, for use if the

material was originally mono and has been conveyed on a

two-channel carrier.

If there is a centre speaker, the combined or selected signal is

played only through this to centrally localise high-frequency hiss

and clicks.

The Academy DSP preset includes an equalisation

(recommended by Lucasfilm Ltd) to correct for a high-frequency

balance in some old mono films.

Mono and Academy DSP preset
parameters

Parameter Options What it changes

Input Auto L+R, Left, The channel selected.

Right, L+R
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Music DSP presets

Music

The Music DSP preset extracts the mono and surround

components of the original recording. These components

provide an alternative representation of the original sound, and

this representation is sometimes used for recording systems or

in broadcasts such as FM radio.

The mono element is equalised using a proprietary Meridian

technique to match the tone colour of the centre speaker, and to

compensate for the fact that the frequency response of human

hearing changes with direction.

The Music DSP preset is recommended for recordings made

with spaced omnidirectional microphones, or using a mono-

surround technique.

Trifield

As for the Music DSP preset, the Trifield preset extracts the

mono and surround components of the original recording. It then

calculates the signals for the front left, centre, and right

speakers, using the phase and amplitude differences between

the three front channels, to redistribute the sounds on a

frequency-dependent basis.

The digital surround controller provides seven alternative music

DSP presets designed for the reproduction of well-recorded

material, originally intended for replay over a traditional stereo

pair of loudspeakers.

In addition, it provides DSP presets for reproducing music in the

digitally encoded DTS, MPEG, and MLP formats.

Audio format Presets

Two-channel (PCM) Direct, Music, Trifield,

Ambisonic, Super Stereo,

Stereo, Music Logic

DTS DTS Music

MPEG MPEG Music

MLP (Meridian Lossless Packing) MLP
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This gives a significant improvement over traditional stereo,

which converts the differences between the microphone signals

into amplitude differences in the speaker signals. This version of

the Trifield algorithm is virtually impossible to implement without

digital signal processing.

Trifield is recommended for well-made recordings and stereo

television broadcasts that are not Dolby Surround encoded. An

advantage over the Music DSP preset is that the front stereo

image is more focused, and the width of the image can be

adjusted.

Music and Trifield DSP preset
parameters

Parameter Options What it changes

Centre Flat, EQ1 to 3 The timbre of the

centre loudspeaker.

Width * 0 to 1.5 The width of the image.

Surr. Rear Surr. Rear, Switches the surround

Surr. Side, Surr. All signal between the

side and rear speakers.

R Filter Off, 1kHz, 3kHz, The cutoff of high

7kHz frequencies from the

rear surrounds.

S Filter Off, 1kHz, 3kHz, The cutoff of high

7kHz frequencies from the

side surrounds.

* Trifield only.
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Ambisonic

The Ambisonic DSP preset is designed for replaying material

encoded in UHJ format, the two-channel stereo-compatible

encoding found on Ambisonically recorded discs and

broadcasts. This material is specifically encoded for surround

reproduction and can give breathtakingly realistic sound when

replayed using the digital surround controller.

Ambisonic surround sound is quite unlike conventional stereo. A

special microphone technique picks up the sound of the original

performance in all three dimensions, allowing an archive to be

made which describes the sound field exactly at that position.

The microphone signals are then encoded using a phase-

amplitude matrix to allow the effect to be conveyed on two-

channel carriers (like FM radio, LP, or CD).

The digital surround controller uses accurately matched,

frequency-dependent, phase-amplitude matrices to decode the

signal and construct the signals for each speaker feed.

The fundamental difference between Ambisonic surround sound

and conventional stereo is that the signals from all the speakers

combine to produce a coherent sound field at the listening

position, giving the illusion that you are sitting inside the

recording space whether you are at the exact central seat or well

off to one side.

Of all the signal-processing options, Ambisonic is the one that

requires the greatest attention to speaker choice and

positioning.

Super Stereo

Super Stereo synthesises a signal from a conventional stereo

recording or broadcast so that it can be decoded using the

Ambisonic decoder. The result is especially effective for two

particular types of recordings:

❍ Those using true coincident microphone techniques.

❍ Multi-tracked or multi-miked recordings.
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Ambisonic and Super Stereo DSP
preset parameters

Parameter Options What it changes

Width * 0 to 1 The width of the image.

Position † A, C, E, G, I, K, M The seating position; the

letters are like rows in a

hall.

5 Channels 7, 6, 5, 4 The number of speakers.

R Filter Off, 3kHz, 7kHz, The cutoff of high

9kHz frequencies from the rear

surrounds.

S Filter Off, 3kHz, 7kHz, The cutoff of high

9kHz frequencies from the side

surrounds.

* Super Stereo only.

† Ambisonic only.

Music Logic

Music Logic is a music DSP preset with user-adjustable

steering, designed to provide an exciting experience with many

types of studio-produced music.

Music Logic DSP preset parameters

Parameter Options What it changes

Roll Off, Low, Med, High The degree of left-right

steering.

Yaw Off, Low, Med, High The degree of front-rear

steering.

Mono Rear Steered Rear, Which of the surround

Steered Side, channels are generated

Steered All, by steering.

Mono All, Mono

Rear, Mono Side
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Stereo and Direct

The Stereo preset passes the left and right input signals directly

to the left and right main speakers. Any mono or front left and

right subwoofers continue to be used.

With the Direct preset only the left and right main speakers are

used.

There are no special DSP preset parameters.

DTS Music

DTS Music is a special version of the DTS preset designed with

a lower LFE level of -10dB to match the bass levels applied to

DTS music CDs.

MPEG Music

MPEG Music is a special version of the MPEG preset designed

for listening to MPEG encoded music CDs.

MLP

MLP (Meridian Lossless Packing) is an audio format that

increases the amount of information that can be recorded on a

CD or DVD, without any loss of quality.

For details of the DTS Music, MPEG Music, and MLP DSP

preset parameters see 5.1 Movie DSP preset parameters,

page 47.
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The discrete digital formats can encode up to eight separate

channels, which can be decoded to provide separate signals to

the eight speakers in a surround configuration.

Dolby Digital

Dolby Digital is a totally digital format capable of encoding five

full frequency-range channels, together with one restricted

frequency-range channel used for extreme bass.

The digital surround controller’s Dolby Digital preset is capable

of decoding the range of different options provided by Dolby

Digital. In addition, it provides bass power management to

protect systems from the potentially high bass levels that Dolby

Digital can produce.

DTS

DTS is unusual among the compressed surround formats in that

it can deliver high quality music at high bit rates.

CDs and LaserDiscs are currently available which provide a DTS

signal in place of the normal digital audio. DVDs may also

feature DTS soundtracks.

MPEG

MPEG surround is the preferred audio format for DVD in PAL

territories.

Dolby Digital THX, DTS THX, and
MPEG THX

As with the standard THX Cinema DSP preset, Dolby Digital

THX, DTS THX, and MPEG THX re-equalise the signals to suit

domestic listening conditions, and applies frequency-response

correction and decorrelation to the surround channels to make

the surround sound more realistic, and can be used whether or

not your other equipment is THX approved.

5.1 Movie DSP presets
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5.1 Movie DSP preset parameters

Parameter Options What it changes

Surr. Rear Surr. Rear, Surr. Side, Switches the surround

Surr. All signal between the side

and rear speakers.

LFE 0 to -30dB The relative level of the

LFE bass channel.

Max SPL * 105 to 120dB SPL The peak-level limit for an

LFE subwoofer.

Limit * -15 to -5dBFS The peak-level limit of the

total bass signal added

to the main speakers.

Compress † Off, Low, Med, The dynamic range

Top, Max, Mix control; see opposite.

* See Using peak-level limiting, page 48.

† Dolby Digital and Dolby Digital THX only.

Using dynamic range control

Because Dolby Digital is a digital format it allows dynamic range

control without the distortion involved in analogue methods. The

Compress parameter can be set to one of the following options:

Option Description

Off No compression.

Low Provides moderate bottom-up compression. This

raises quiet sounds above the background noise,

which is ideal for demonstration and quiet listening.

Med Provides moderate amounts of both bottom-up and

top-down compression.

Top Provides a moderate amount of top-down

compression. This reduces loud sounds.

Max Provides full bottom-up and top-down compression.

Quiet sounds are raised to be audible and loud

passages are minimised to avoid disturbance, which

is useful for late-night listening.

Mix Bypasses dialogue normalisation and references the

sound pressure level in the studio where the material

was mixed.
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Using peak-level limiting

The Max SPL or Limit parameters allow you to set up peak-level

limiting for bass signals, and the setting applies to all the

discrete digital DSP presets.

If your loudspeaker layout includes one or more subwoofers the

parameter is named Max SPL, and it sets the peak-level limit for

the LFE channel.

If your loudspeaker layout contains no subwoofer the parameter

is named Limit, and it sets the peak-level limit of the bass signal

added to the main loudspeakers. For loudspeaker layouts using

Meridian DSP loudspeakers as the main left and right, or centre

speakers, the Limit value is fixed at -11dBFS and the parameter

does not appear in the menu.
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Setting up the digital
surround controller

This chapter explains how to install the digital surround controller. It

describes what you should find when you unpack the processor, how you

should connect it to your other audio equipment and speakers, and the

siting constraints.

Before you begin installation you should ensure that your digital surround

controller is the correct voltage for you local AC supply. If it is not, do not

try to install the unit, and contact your dealer.

You should not make any connections to the digital surround controller, or

to any other component in your system, while the AC power supply is

connected and switched on.
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Unpacking

❍ Near to a television, or where connecting cables may be

subject to or cause interference.

To avoid overheating ensure that air can flow through the

cooling slots on the base and top cover. Alternatively, an

optional Fan kit can be fitted to ensure adequate ventilation

when the 561 is installed in an enclosed space.

Radio interference

FCC Warning: This equipment generates and can radiate radio

frequency energy and if not installed and used correctly in

accordance with our instructions may cause interference to

radio communications or radio and television reception. It has

been type-tested and complies with the limits set out in Subpart

J, Part 15 of FCC rules for a Class B computing device. These

limits are intended to provide reasonable protection against

such interference in home installations.

EEC: This product has been designed and type-tested to

comply with the limits set out in EN55013 and EN55020.

The digital surround controller comes in a box containing the

following components:

❍ Meridian 561 Digital Surround Controller.

❍ Meridian System Remote.

❍ Power cord.

❍ 500 Series communications lead.

❍ RS232 computer serial lead.

❍ This manual.

If any of these items are missing please contact your dealer. We

suggest that you retain the packing in case you need to

transport the unit.

To position the digital surround
controller

Do not place the digital surround controller:

❍ In direct sunlight.

❍ Near heat sources, such as radiator.

❍ Directly on top of heat producing equipment, such as a power

amplifier.

❍ Near strong magnetic radiation, such as a near a power

amplifier.
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Rear panel

Use this input To connect to this

VCR1/V1, TV/V2, The composite video output from a

V3, Cable/V4 video recorder, TV tuner, or cable

television.

DVD/S1, LD/S2, The S-video output from a DVD player,

VCR2/S3, DTV/S4 LaserDisc player, video recorder, or

digital television tuner.

Video inputs

The table opposite gives details of the video inputs.

The video inputs V4 and S4 include DC rejection, for video

signals with a DC offset.

OFF

COMMS
RS232

ON

Tape2/D4LD/O1 DVD/D2

CDR/D3DTV/D5 CD/D1
DIGITAL IN

Meridian Comms Only

Tape Out

CentreRear L Main/Side
ANALOGUE OUT

Sub Main/SideRear R

TAPE OUT
Room 2 Tape

A6A7 A5 A4 A3 A2 A1

VCR1VCR2 Cable TV Tape1 Radio CD
ANALOGUE IN

Cable/V4 LD/S2 DTV/S4

VCR Outs

Side/SubRear Centre/Sub Main

5/67/8 3/4 1/2

DIGITAL OUT VIDEO IN VIDEO OUT
Main Outs

VCR2/
S3

DVD/
S1

V3VCR1/V1
TRIGGER OUT

1 2

L

R

L

R

L

R

L

R

TV/V2

Comms Digital
speakers

Analogue
inputs

Digital
inputs

Power input
and fuse

Composite
video inputs

S-video
inputs

Video
outputs

Optical
input

PC

Expansion
socket

Analogue
speakers

Analogue
tape outputs

Digital tape
output

Connecting the digital surround controller
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Video outputs

The following table gives details of the video outputs. All outputs

include the 561 on-screen display.

When an S-video source is selected the S-video output is also

converted to composite and fed to the composite outputs.

However, to take advantage of the higher quality available from

S-video sources it is recommended that you also connect the

S-video output to the television or monitor.

Use this output To connect to this

Main Outs (composite) The composite video input of a

television or monitor.

Main Outs (S-video) The S-video input of a television or

monitor.

VCR Outs A video recorder. The composite VCR

Outs output will enable you to record

either composite or S-video sources.

Digital audio inputs

The following table gives details of the digital audio inputs:

Use this input To connect to this

CD/D1, DVD/D2, A digital source, such as a CD player,

CDR/D3, Tape2/D4, DVD player, digital tape recorder, or

DTV/D5 digital television tuner.

LD/01 A digital-optical source, such as a

LaserDisc player, the 519

Demodulator, or a CD player with no

digital-cable output.

The digital connections should be made with high-quality 75Ω
screened cable. Suitable cables are available from Meridian. We

do not recommend using audio cables, which do not have

adequate shielding or the correct impedance, or cables intended

for UHF applications, as these do not provide adequate

shielding in the 1–30MHz region.

Optical connections should be made using a suitable optical

fibre supplied by your dealer.
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Analogue audio inputs

The following table gives details of the analogue audio inputs:

Use this input To connect to this

CD/A1, Radio/A2, An analogue source such as a

Tape1/A3, TV/A4, radio tuner, tape recorder, TV

Cable/A5, VCR1/A6, tuner, or cable television.

VCR2/A7

The analogue connections should be made using high-quality

screened cable, taking care to connect the left and right

channels correctly.

Audio outputs

The following table gives details of the analogue and digital

outputs:

Use this output To connect to this

Main 1/2 Main left and right speakers.

Centre/Sub 3/4 Centre speaker and centre or mono

subwoofer.

Sides/Sub 5/6 Left and right subwoofers, or side left

and side right surround speakers.

Rear 7/8 Left and right rear surround speakers.

To use a Meridian DSP loudspeaker in a particular position

connect it to the appropriate digital output.

To use a Meridian active loudspeaker, or an analogue speaker in

conjunction with a suitable power amplifier, connect the input of

the power amplifier to the appropriate analogue output.

If the main speakers are analogue, connect them to the Main/Side

analogue outputs. If the main speakers are digital, the Main/Side

analogue outputs can be used for analogue side speakers.
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Audio tape and expansion socket
outputs

The following table gives details of the tape and headphone

outputs:

Use this output To connect to this

DIGITAL Tape Out A digital tape recorder.

Tape L, R An analogue tape recorder or video

recorder.

Room 2 L, R A second tape recorder or a Meridian

preamplifier in a second room.

Expansion socket * Additional expansion output.

* The function of the expansion socket depends on the

expansion card fitted. The optional Tape card provides a

headphone output.

Control outputs

The following table gives details of the control outputs:

Use this output To connect to this

TRIGGER OUT 1 Other equipment. On when the 561 is

switched on but not in standby.

TRIGGER OUT 2 A TV SCART input or motorised

screen. On for S-video sources.

The trigger outputs provide 100mA at 9V. They can be

configured to other settings; see Configuring the digital surround

controller without a computer, page 65.
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Communications connections

The following table gives details of the communications

connections:

Use this connection To connect to this

COMMS Other Meridian 500 Series

equipment, and the master

digital speaker.

RS232 The serial port of a PC, to

configure the 561. See

Configuring the digital surround

controller without a computer,

page 65.
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To connect to a television or monitor

S-video lead

561 Digital Surround Controller

MONITOR IN

Television

S-video Composite
VIDEO OUT
Main Outs

Composite video lead

The 561 digital surround controller provides switching of both

composite and S-video sources.

● Connect the composite Main Outs VIDEO OUT socket to the

composite input of your television or monitor using a

composite video lead.

S-video sources are converted to composite and are also

available on the composite output.

However, for highest quality from S-video sources it is

recommended that you connect the S-video Main Outs VIDEO

OUT socket to the S-video input of your television or monitor,

using an S-video lead, and select this when viewing an S-video

source.

The 561 adds a text overlay to the video signal from the Mains

Outs video outputs, to provide additional information about its

operation in the form of a textual on-screen display (OSD). In

normal operation this repeats the information provided on the

561 front panel display. During calibration, and when resetting

the 561, the on-screen display provides additional guidelines to

help you perform the calibration sequence.

The on-screen display automatically locks to an NTSC, PAL, or

SECAM signal, and requires an input signal to operate.

Connecting video
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To connect to Meridian DSP
loudspeakers

DSP5000C
Centre (master)

DIGITAL OUTPUTSCOMMS

COMMS
OUTPUT INPUT

DIGITAL
OUTPUT

DIGITAL INPUTS
2 1

COMMS
OUTPUT INPUT

DIGITAL
OUTPUT

DIGITAL INPUTS
2 1

COMMS

OUTPUT

INPUT

DIGITAL
OUTPUT

DIGITAL
INPUTS

1

2

S5 lead

S5 lead

M5 lead

S5 lead (digital unused)

DSP5000 – Main R DSP5000 – Main L

561 Digital Surround Controller

511 S-patch box

● Use the comms part of an M5 lead to connect one of the

COMMS sockets on the 561 to the digital speaker you have

chosen as the master (typically the centre speaker).

● Use the audio part of the M5 lead to connect the digital

speaker to the appropriate DIGITAL OUT socket.

● If your system includes more than two Meridian DSP

loudspeakers you will need a 511 S-patch box (available

separately) to link together the S5 leads from each speaker.

Connect the COMMS output from the master digital speaker

to one socket on the 511 using an S5 lead.

● Link all the other digital speakers together using S5 leads, as

shown in the illustration. The other sockets on the 511 can be

used to distribute the comms to each slave speaker.

● Use the duplicate sockets on each digital speaker to link the

speakers together in pairs, corresponding to the pairs of

channels on the digital outputs.

Connecting speakers
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To connect to active loudspeakers
(eg Meridian M33s)

R

561 Digital Surround Controller

L

M33 Active
Loudspeaker

Audio leads

INPUTMain/SideINPUT

M33 Active
Loudspeaker

● Connect the appropriate ANALOGUE OUT sockets from the

digital surround controller to the speaker inputs, using

screened audio cable.

You can connect the 561 to up to two pairs of active

loudspeakers and a centre speaker.

To connect to a stereo power
amplifier (eg Meridian 556)

556 Stereo Power Amplifier

INPUTINPUT

R

561 Digital Surround Controller

L

Audio leads

Main/Side

● Connect the appropriate ANALOGUE OUT sockets from the

digital surround controller to the stereo power amplifier line

inputs, using screened audio cable.

● Connect the speaker outputs from the stereo power amplifier

to suitable speakers.
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To connect an active subwoofer
(eg Meridian M1500 or M2500)

Sub

561 Digital Surround Controller Subwoofer

Audio lead

DIRECT
INPUT

CROSSOVER
INPUT

● Connect the Sub ANALOGUE OUT socket from the digital

surround controller to the subwoofer’s line level input.

The digital surround controller provides very high-quality

crossovers for the subwoofer, and for best results you should

use these instead of the subwoofer’s crossover. To do this set

the subwoofer filtering to Narrow, and remove any crossover in

the subwoofer or set it to its highest setting (eg 200Hz). If you

cannot do this set the subwoofer filtering to wide to switch off

the digital surround controller’s crossover and use Gain/Sub

mode to match the subwoofer’s crossover frequency. For more

information see To specify the type of subwoofer, page 90.

If you are using an M1500 or M2500 use the L+ input and

configure it for Bypass; refer to the subwoofer’s user guide for

more information.
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Connecting sources

To connect to a digital source
(eg Meridian 508.24 24-Bit CD Player)

508.24 24-Bit CD Player

Digital lead

DIGITAL IN
CD/D1

561 Digital Surround Controller

DIGITAL
OUTPUT

ANALOGUE IN
CD/A1

ANALOGUE
OUTPUTS

Audio lead

You can connect up to five digital sources to the 561 Digital

Surround Controller.

● Connect the digital source to one of the DIGITAL IN sockets,

of the 561, using a high-quality digital phono lead.

● If the digital source provides an analogue output, and you

want to be able to make analogue tape recordings of the

source, connect the analogue output to one of the

ANALOGUE IN sockets.

By default the CD/A1 input is copied to the analogue tape

output when you copy the CD source.

To connect to an analogue source
(eg Meridian 504 FM Tuner)

ANALOGUE IN
Radio/A2

504 FM Tuner

OUTPUT

561 Digital Surround Controller

Audio lead

You can connect up to seven analogue sources to the 561

Digital Surround Controller.

● Connect the analogue source to one of the ANALOGUE IN

sockets of the 561, using a standard phono lead.



S
e

ttin
g

 u
p

 th
e

 d
ig

ita
l s

u
rro

u
n

d
 c

o
n

tro
lle

r

61

To connect to a DVD player
(eg Meridian DVD Player)

S-video lead

561 Digital Surround Controller

VIDEO IN
DVD/S1

Meridian DVD Player

DIGITAL IN
DVD/D2

DIGITAL
OUT

S-video
output

Digital lead

● Connect the S-video output from the DVD player to the

DVD/S1 VIDEO IN socket of the 561, using an S-video lead.

● Connect the digital output from the DVD player to the DVD/D2

DIGITAL IN socket of the 561, using a digital lead.

To connect to a LaserDisc player

OPTICAL
OUTPUT

561 Digital Surround Controller LaserDisc player

Meridian 519
Demodulator

OPTICAL
OUTPUT

OPTICAL
INPUT

RF
INPUT

RF
OUTPUT

Optical lead

RF
lead

Optical
lead

DIGITAL IN
LD/O1

VIDEO IN
LD/S2

VIDEO
OUT

S-video lead

● Connect the S-video output from the LaserDisc player to the

LD/S2 VIDEO IN socket of the 561, using an S-video lead.

● Connect the RF output from the LaserDisc player to the 519

RF input.

● Connect the optical output from the LaserDisc player to the

519 optical input, and the 519 optical output to the LD/O1

DIGITAL IN socket on the 561, using optical leads.
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Connecting to a tape recorder

To connect to a digital recorder

DIGITAL IN

561 Digital Surround Controller Digital recorder

Digital
Output

Digital leads

Tape Out Tape 2/D4
Digital
Input

● Connect the Tape Out socket on the 561 Digital Surround

Controller to the recorder’s digital input.

● Connect the recorder’s digital output to the Tape2/D4

DIGITAL IN socket on the 561.

This will allow you to record a digital source by copying it to the

tape output.

By adding the optional Tape card you will also be able to record

analogue sources to the digital tape output.

To connect to an analogue recorder

ANALOGUE IN
Tape1/A3

Analogue Recorder

AUDIO

561 Digital Surround Controller

TAPE OUT
Tape INOUT

Audio leads

● Connect the Tape TAPE OUT sockets on the 561 Digital

Surround Controller to the recorder’s input sockets.

● Connect the recorder’s output sockets to the Tape1/A3

ANALOGUE IN sockets on the 561.

This will allow you to record an analogue source by copying it to

the tape output.

To record a digital source either connect its analogue output to

one of the 561 analogue inputs, or add the optional Tape card.
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To connect to a video recorder

VCR1/A6

Video Recorder

AUDIO

561 Digital Surround Controller

Video leads

INOUT
VCR1/V1 VCR Outs

IN OUT
VIDEO

Audio leads

TAPE OUT
Tape

● Connect the Tape TAPE OUT sockets on the 561 Digital

Surround Controller to the video recorder’s audio inputs.

● Connect the video recorder’s audio outputs to the VCR1/A6

ANALOGUE IN sockets on the 561.

● Connect the appropriate VCR Outs VIDEO OUT socket on the

561 Digital Surround Controller to the video recorder’s video

input.

● Connect the video recorder’s video output to the VCR1/V1 or

VCR2/S3 VIDEO IN socket on the 561, as appropriate.

Note that DVD video discs include a special feature so that they

cannot be recorded.
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To connect to other Meridian 500
Series equipment

● Connect one of the COMMS sockets on the back panel of the

561 Digital Surround Controller to one of the COMMS sockets

on another 500 Series unit, using the 500 comms lead

provided with the digital surround controller.

The sequence in which you connect the units is not important.

561 Digital Surround Controller 500 Series unit

COMMS COMMS

Then configure the units with the following automatic setup

procedure:

● Switch all the units to standby.

● Press CLEAR (remote).

Each unit will display:
Auto Setup

Connecting to other Meridian equipment

One unit will then be designated

as the controller, and display:
Controller

This is the unit that will respond to the remote.

All the other units will be configured

as non-controllers, and display:
Not Con.

Your system is now set up and ready for use.

● If for any reason the automatic setup does not give the

configuration you want, restore the default operation by

selecting one of the standard types; see Choosing a standard

setting, page 66.

Note: Do not, under any circumstances, connect any equipment

other than Meridian 500, 600, or 200 Series to the socket

marked COMMS on the back of the digital surround controller.
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Configuring the digital
surround controller
without a computer

The 561 Digital Surround Controller can be set up for most standard

configurations of loudspeakers and sources using just the front-panel

controls and Meridian System Remote.

This chapter explains how to configure the digital surround controller

without using a computer, and then how to calibrate the loudspeakers and

sources for your particular system.

Alternatively, for complete control over all aspects of the digital surround

controller’s configuration you can set up the unit from a computer using

the Meridian Configuration program. For full information refer to the next

chapter.



C
o

n
fi

g
u

ri
n

g
 t

h
e

 d
ig

it
a

l 
s
u

rr
o

u
n

d
 c

o
n

tr
o

ll
e

r 
w

it
h

o
u

t 
a

 c
o

m
p

u
te

r

66

Choosing a standard setting

The digital surround controller provides 39 alternative standard

settings, called Types, which configure all aspects of the 561

into the most commonly needed configurations. In addition, any

User Types you create using the Meridian Configuration

program are also available.

Choosing one of the Types overrides any other configuration you

may have performed, and so can be used to reset the

configuration of the unit.

If your digital surround controller is connected to a television or

monitor, the on-screen display also provides additional text

explaining what to do. For information about setting up the on-

screen display refer to Connecting video, page 56.

The Type you choose depends on the following aspects of your

system:

❍ The number of speakers in your system.

❍ Whether your system includes a subwoofer.

❍ Whether the speakers are analogue or digital.

The following diagram shows the meaning of the standard Type

codes:

Type 5.S DAA

Main/centre/surround
speaker types:
D Digital
A Analogue

Number of main speakers:
2 Main only
3 Main & centre
4 Main & rear
5 Main, centre, & rear
7 Main, centre, side, & rear

Subwoofer:
0 No sub
1 Mono/THX sub
S Special sub

The Special sub option gives no subwoofer for Music DSP

presets, a centre subwoofer for Logic presets, and an LFE

subwoofer for 5.1 Movie presets.
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To select a Type

● Select a video source to produce an on-screen display.

● Put the digital surround controller into standby by pressing

Off (front panel or remote).

● Hold down the A key on the front

panel until the display shows:
Type in... 5

● Keep holding down the A key for a

further 5 seconds.

The display will show:
Type- Wait..

Followed by the current Type setting;

for example:
Type 5.1 AAA

● Press ▲ or ▼ on the front panel to select the Type.

For example, if you have two analogue

speakers the display shows:
Type 2.0 A--

● Wait for a few seconds, while the

display shows:
Typing, wait

● Press the Off key on the front panel.

The display shows:
Exiting Type
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Standard source settings

The digital surround processor provides 12 sources

corresponding to the 12 source selection keys on the Meridian

System Remote.

When the digital surround processor is reset to one of the

standard Types the sources are set up with the labels, inputs,

and presets shown in the table below.

Source Audio Video 2-channel Digital DTS MPEG

input input preset preset preset preset

CD CD/D1 – Trifield Digital DTS Mus MPEG Mus

Radio Radio/A2 – Music Digital DTS Mus MPEG Mus

DTV DTV/D5 DTV/S4 Music Digital DTS MPEG

TV TV/A4 TV/V2 TV Logic Digital DTS MPEG

Tape 1 Tape1/A3 – Music Digital DTS MPEG

Tape 2 Tape2/D4 – Music Digital DTS MPEG

CDR CDR/D3 – Trifield Digital DTS MPEG

Cable Cable/A5 Cable/V4 TV Logic Digital DTS MPEG

DVD DVD/D2 DVD/S1 Trifield Digital DTS MPEG

VCR 1 VCR1/A6 VCR1/V1 Pro Logic Digital DTS MPEG

VCR 2 VCR2/A7 VCR2/S3 Pro Logic Digital DTS MPEG

LD LD/01 LD/S2 THX Cinema Digital THX DTS THX MPEG THX
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Calibrating the system

To help you to set up your installation to give the best possible

sound with any particular combination of associated equipment,

the 561 Digital Surround Controller includes a built-in calibration

procedure.

This calibration procedure uses test signals to present a series

of sounds, which you use to adjust certain aspects of the

system to their optimum settings.

You should work through the calibration procedure the first time

you set up your surround sound system, and whenever you want

to check the calibration, such as after changing the layout of

your room.

Using the calibration procedure

We recommend that you perform the calibration procedure

using the Meridian System Remote and from the listening

position.

As you run the calibration procedure the name of each

calibration test is shown on the front-panel display, followed by

the parameters adjusted in the test.

If your digital surround controller is connected to a television or

monitor, the on-screen display also provides additional text

explaining what to do. For information about setting up the on-

screen display refer to Connecting video, page 56.

Each calibration test uses a test signal designed to give the best

results.

Using a Sound Pressure Level meter

Although you can perform the calibration procedure by ear, it is

recommended that you perform the tests using a Sound

Pressure Level meter. These are available fairly cheaply from

Tandy/Radio Shack, or your Meridian dealer may be able to lend

you one.

Set the Sound Pressure Level meter to C weighted, and Slow.

Take readings with the meter at the listening position, pointing

vertically. You should hold the meter with an outstretched arm to

minimise reflections from your body.
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To choose the distance units

You can choose to display and enter distances in either feet and

inches, or metres.

To change the distance units:

● Put the digital surround controller into standby by pressing

Off (front panel or remote).

● Press and hold the V key on the front panel for at least five

seconds.

The display shows the distance

units:
Metres 


Or:
Feet/Inches

To start the calibration procedure

● Select a video source to produce an on-screen display.

● Put the digital surround controller into standby by pressing

Off (front panel or remote).

● Press and hold the Off key on the front panel for at least five

seconds.

The display shows:
Calibration

If you have an on-screen display it shows:

After a few seconds the display

shows:
Left    +0.0
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For more detailed information about this and the other

calibration tests see the following sections.

To move between the calibration tests

● Press > (remote) to move to the next test.

● Press < (remote) to move back to an earlier test.

● Press Store to jump to the next set of tests.

The calibration tests are described in the following sections.

To exit from the calibration procedure

You can exit from the calibration procedure at any time, and any

parameters you have set will be retained.

● Press Off (front panel or remote).
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Levels

These tests allow you to adjust the output level to each speaker

individually, and it follows the general guidelines from Dolby

Laboratories and Lucasfilm. A Sound Pressure Level (SPL) meter

can be useful at this stage; ask your dealer for more information.

In each test the display shows the speaker being tested, and the

current relative level.

For example:
Left    +0.0


If you have an on-screen display it shows:

● Use the > and < keys to move between each of the speakers

in the layout in the sequence: Left, Centre, Right, Side R, Rear

R, Rear L, Side L, and subwoofers.

● Use A and V to adjust the level of the speaker. Ignore any

tonal difference.

For correct THX reproduction you should adjust each speaker to

75dB SPL using an SPL meter. Even if your speakers are not

THX approved this setting is recommended.

If you have Meridian DSP loudspeakers they cannot be set

above +0db.

Note that you cannot set the level of a subwoofer by ear,

because low-frequency noises sound quieter. To set the

subwoofer correctly either use an SPL meter, or set it by ear and

then reduce the subwoofer gain by 15dB to correct for human

hearing.

● When you have completed the Levels section press > or

Store to proceed to the next test.

Calibration tests
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Distance

These tests allow you to adjust the delay of each of the speakers

in the layout to time-align the system so that sounds are

coincident when they arrive at the listening position.

Before setting up the speaker outputs you need to measure the

distance to each speaker from the listening position:

CentreSubLeft Right

Left
Side

Right
Side

Left Rear Right RearSurround Sub

Measure from the ear height at the listening position to the

tweeter on each speaker (where applicable), in the distance units

you have chosen; see To choose the distance units, page 70.

● Use the > and < keys to move between each of the speakers

in the layout.

The display shows the speaker being

tested, and the distance:
Left    18'0

If you have an on-screen display it shows:

● Use A and V to change the distance.

Repeat this for each of the speakers in your layout.

● Press > or Store to proceed to the next calibration stage.
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Fine tuning

These tests allow you to fine-tune the phase and delay of each

speaker when used in conjunction with other speakers on the

layout.

● Use the > and < keys to move between each of the speakers

in the layout.

The first display allows you to adjust the phase.

For example:
Left       +

If you have an on-screen display it shows:

The next display shows the distance (or delay) for the same

speaker.

For example:
Left    18'0

If you have an on-screen display it shows:

Choose the correct setting as follows:

Setting What it sounds like

Correct The sound between the speakers is

very even, and does not change

radically as you move your head.

Incorrect The sound appears diffused, and

changes in timbre and apparent

location as you move your head.
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Pay particular attention to the centre channel, as this can have a

dramatic effect on the overall sound.

As you increase the delay the speaker will appear to move away

from you.

You have now completed the calibration of your system.

● Press Off (front panel or remote) to exit from the calibration

procedure.
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Setting up sources

This section explains how to use Gain/Sub mode to set up the

sources connected to the digital surround controller, and

configure them to suit your other equipment.

You can also adjust the subwoofer crossover frequency to suit

the subwoofers in your system.

To turn on Gain/Sub mode

● Put the digital surround controller into standby by pressing

Off (front panel or remote).

● Press and hold the Mute key on the front panel for at least

five seconds.

The display shows:
Gain/Sub On

The 561 will then return to standby with Gain/Sub mode turned

on.

Gain/Sub mode adds three extra options to the DSP parameter

menus: Gain, Xover, and Sine.

To turn off Gain/Sub mode

● Repeat the above procedure until

the display shows:
Gain/Sub Off

To adjust the sensitivity of analogue
sources

The 561 contains a very high-quality Analogue to Digital

Converter (ADC) which allows analogue sources to take

advantage of our unique surround modes and the highly

transparent DSP volume control.

To obtain the best signal-to-noise ratio for your analogue inputs

you can adjust the sensitivity of each input to give the highest

level which does not produce clipping. Clipping in the ADC can

sound very unpleasant and can occur at any output volume

level.

For each analogue input, the sensitivity should be set using the

loudest passages in the loudest source material available, such

as the commercials on a TV channel. While setting the sensitivity

you can choose any surrround mode or volume level, as these

do not affect the input level.
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● Turn on Gain/Sub mode, as described above.

● Select the source you want to adjust, with loud source

material playing.

The display shows a Clip indicator, and the current sensitivity of

the source in dB.

For example:
Radio •   +9

If you have selected a digital source you cannot adjust the

sensitivity and the display shows NA.

The Clip indicator changes to show the peak input level as

follows:

Display What it means

Radio ••••+9
Input clipped; reduce sensitivity.

Radio ••• +6
Input correct; just below clipping.

● Press < or > (remote) until the

display shows:
Gain  •   +9

● Press A or V (remote) to adjust the sensitivity until three bars

are showing in the loudest passages.

● Repeat for any other analogue sources you want to adjust.

● Turn off Gain/Sub mode, as described above.

To adjust the subwoofer crossover
frequency

The 561 allows the crossover frequency for any subwoofers

which you have to be adjusted between 30 and 120Hz. The

crossover can be set independently for Music, Logic, and 5.1

Movie presets. The default is the THX standard of 80Hz.

● Turn on Gain/Sub mode, as described above.

● Press < or > (remote) until the display shows the current

crossover frequency.

For example:
Xover  80Hz

● Press A or V (remote) to set the crossover frequency.
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For THX loudspeaker systems you should not adjust these

settings – they should be left at 80Hz. 80Hz is also the

recommended setting for all movie listening. You may prefer,

however, to lower the crossover frequency for music if your main

speakers have good bass handling down to, say, 50Hz.

To use the sinewave sweep test

Gain/Sub mode includes a sinewave signal test, to help you set

the subwoofer crossover frequencies, or check for room

resonances.

● Turn on Gain/Sub mode, as described above.

● Press < or > (remote) until the

display shows:
Sine     Off

● Press A to turn on the sinewave signal.

The display shows:
Pause   80Hz

● Press A or V to start the sinewave sweeping up or down in

frequency, respectively. Press the key twice to sweep more

quickly.

The display shows the direction and frequency.

For example:
Sine >>175Hz

You can then use the A or V keys to change the speed or

direction of sweep, pause the sweep, or turn off the sinewave.
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Configuring the digital
surround controller
using a computer

The 561 Digital Surround Controller provides a flexible range of

customisation options which you can change to suit your own preferences

and the other equipment in your system. To configure the 561 you use the

Meridian Configuration program, an intelligent Windows-based application

that is supplied with the 561. This allows you to create one or more custom

configurations, and download them to the 561 so that they are available

alongside the built-in types.

This chapter explains how to install the Meridian Configuration program,

and then how to use it create your own configurations of the 561.
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based application that lets you design your own configuration of

the 561 Digital Surround Controller to suit your own personal

preferences and the particular configuration of equipment in

your system.

The Meridian Configuration program provides the following

sections to allow you to control the corresponding aspects of

the digital surround controller’s operation:

Setup

Lets you specify general features of the digital

surround controller’s operation, including the

position of the on-screen display, the information

provided on the front panel displays, the startup

volume, and settings affecting its operation in multi-

room systems.

Speakers

Lets you configure the digital surround controller to

suit the layout of the loudspeakers in your system,

and the type of each speaker, to ensure that you

get perfect surround sound performance.

The Meridian Configuration program

Sources

Lets you customise the operation of each of the

sources, including the presets used by each source

for each of the audio formats, the digital, analogue,

and/or video inputs used for that source, and

additional information about the type of each

source.

Presets

Lets you customise the settings of the built-in DSP

presets, and create additional presets of your own

based on the built-in presets.
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Requirements

To use the Meridian Configuration program you need:

❍ A computer running Windows 95 or Windows NT 4.00.

❍ A 100MHz or faster Pentium-class processor.

❍ At least 16 Mbytes of RAM.

❍ 5 Mbytes of free disk space.

❍ A vacant 9-pin serial port assigned to one of COM1 to 4.

The software requires a mouse or similar pointing device – it

cannot be operated solely from the keyboard.

To install the Meridian Configuration
program

● Insert the first Meridian Configuration program installation

disk.

● Choose Run... from the Start menu.

● Type A: setup and press R.

● Follow the on-screen instructions, inserting the second

installation disk when prompted.

Planning the configuration

Before creating a configuration for your 561 Digital Surround

Controller it is a good idea to plan the following aspects of your

setup:

❍ How you are going to set up the different speakers in your

layout.

❍ Whether the bass is going to be handled by the main

speakers, or by one or more subwoofers.

❍ Which analogue, digital, or video inputs you are going to use

for each of your sources.

❍ Which DSP preset you want as the default preset for each

source and audio format.

Installing the Meridian Configuration program
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r Button Option Function

New Creates a new settings file.

Open Opens an existing settings file.

Save Saves the current settings file to

disk.

Fetch Fetches the current configuration

of the attached product(s).

Store Stores the current settings and

User Types to attached products.

Disconnect Disconnects the program from

attached products.

Copy Copies text or settings onto the

clipboard.

Paste Pastes text or settings from the

clipboard.

About Displays program information.

To run the Meridian Configuration
program

● Click Start, point at Programs, then click Meridian

Configuration.

The Meridian window will be displayed:

The toolbar provides a convenient way of accessing the most

important menu options:
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To connect the serial cable

The serial cable is symmetrical, and can be connected either

way round.

● Connect one end to the RS232 connector on the back panel

of the 561 Digital Surround Controller.

● Connect the other end to one of the serial ports on the PC or

PC notebook computer.

Then specify the serial port you are using as follows:

● Choose Options from the View menu to display the Options

dialogue box:

● Select the port you want to use and click the OK button.
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Creating a new settings file

To display the settings

● Double-click the Surround controller icon, to open it and

display the settings it contains.

The left-hand panel of the Meridian window will change to show

the following three icons:

Owner lets you enter personal information, for future reference,

and choose the message displayed when you first switch the

unit on, and Settings is the initial configuration in the settings

file.

Double-clicking Return to top level takes you back to the

previous level.

The section explains how to create a new settings file, using the

Meridian Configuration program, and how to enter personal

information to identify the settings in your 561.

● Choose New from the File menu, or click the

New button in the toolbar:

A new settings file will be created for you, with the initial name

MSF1, and the Meridian window will show a 561 Surround

controller icon to identify the product you are configuring.

● Choose Save As from the File menu, enter an appropriate

name for the file, such as your name, and click the Save

button.
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The options on the Advanced tab are for use by dealers in

setting up multi-room systems, and to upload a new version of

the software to the product, and it is recommended that you do

not change these settings.

To display or edit the settings

● Double-click the Settings icon.

The Meridian window will change to show the four categories of

settings contained in the settings file: Setup, Speakers,

Sources, and Presets.

The options available in each case are explained in the following

sections.

At this stage you may find it useful to maximise the Meridian

Configuration program window so you can see all the options on

each screen.

To enter your personal details

● Click the Owner icon in the left-hand panel.

● Enter any text you like in the Dealer, Owner, and Description

fields.

You can enter up to 12 characters in each field, the size of the

561 front-panel display.

The Owner text will be displayed when you turn the 561 on. The

Dealer and Description text are displayed after the product

version and serial numbers if you hold down the front-panel

Display key in standby.
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program to configure the 561 Digital Surround Controller for the

configuration of loudspeakers in your system, and specify

information about the type of each speaker, for optimum

performance.

The first stage in setting up the speakers is to specify the

number of speakers in the layout, and the type and size of each

speaker.

The 561 Digital Surround Controller can support up to 8

loudspeakers, or up to 6 loudspeakers if the front speakers are

analogue.

To specify the speaker layout

● Click Speakers in the left-hand panel of the Meridian

window.

● If necessary click the Layout tab to display the Layout page

of speaker settings:

● Specify the type of each speaker by selecting the appropriate

option from each of the drop-down menus.

Setting up speakers
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As you change the options the layout illustration will change to

show the resulting layout.

If you select a combination of options that is not supported, the

other options will be adjusted accordingly to ensure that the

whole configuration is valid.

For example, if you specify two sides and two rears, and then

select two subwoofers, the side speakers will be removed to

enable you to have the subwoofers.

To specify the size and type of the
main speakers

● Choose Large if your main left and right speakers are large,

with good bass performance, and you want to use them for

full range reproduction.

● Choose Small if your main left and right speakers do not have

a good bass response and you want to use one or more

subwoofers to handle the bass for the system.

● Choose analogue or DSP according to the type of each

speaker.

The following table gives recommended settings for Meridian

loudspeakers:

Loudspeaker Recommended setting

DSP5000, DSP5500, Large DSP

DSP6000, or DSP6000C

DSP5000C Small DSP

M60 Large analogue

M60C, M33, or A500 Small analogue
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centre speaker

● From the first drop-down menu choose one of the following

options:

Option Description

None If you do not have a centre speaker.

Movies only If you want to use the centre speaker for

Logic and 5.1 Movie DSP presets only.

Movies and music If you want to use the centre speaker for

all presets.

● From the second drop-down menu specify the type of the

centre speaker; the options are as for the main speakers.

To specify the number and types of
surrounds

● Choose the appropriate option depending on the number of

rear speakers and side speakers you have in your surround

system.

● Specify the types of the rear and side speakers.

To specify the number of subwoofers,
and the DSP presets that use them

If your main left and right speakers are small you will need to use

one or more subwoofers to handle the bass. You can choose

between appropriate combinations of mono (front), centre, left

and right, or surround.

If your main left and right speakers are large you can use one or

more subwoofers to augment the bass from the centre channel.

With 5.1 sources an additional option is to use the subwoofer

only for the LFE channel.

You can specify a different subwoofer configuration for Music,

Logic, and 5.1 Movie DSP presets.

The Advanced checkbox is for dealer use only, and it is

recommended that you leave this unchecked unless you have

special requirements.
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Once you have specified the speaker layout for your system the

Sizes page of settings allows you to set up speaker protection

for the 5.1 sources.

To set up speaker protection

Because of the high bass levels that 5.1 materials are capable of

reproducing, the digital surround controller allows you to set up

automatic protection of each full-range speaker or subwoofer.

A setting of Max corresponds to no protection, and 0

corresponds to full protection. By default any Meridian DSP

loudspeakers in your system are set to Max, as these include

built-in protection.

You can use SizeCalc to help you calculate the correct value for

your speakers:

● Click the Size calculator button to display the SizeCalc

window:

● Specify the number of bass units in each speaker (woofers),

the size of each unit, and the design of the speaker.

The size value is displayed in the SizeCalc display.

● Type the size into the appropriate field.

If you prefer you can copy and paste the size directly.

Setting the speaker sizes
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is named Bass limit, and it sets the peak-level limit of the bass

signal added to the main loudspeakers. For loudspeaker layouts

using Meridian DSP loudspeakers as the main left and right, or

centre speakers, the Bass limit value is fixed at -11dBFS and

you cannot adjust it.

To complete the speaker setup

You have now completed the first stage of setting up the 561,

and you should save the changes you have made by choosing

Save from the File menu.

You can ignore the Distances, Crossovers, Precision, and

Phase/Gain pages of settings for the moment; these will allow

you to check the values you have set up when you calibrate

the 561.

To specify the type of subwoofer

For each subwoofer in the system you can specify the

subwoofer filtering. The options are explained in the following

table:

Option Description

Narrow The digital surround controller provides

a low-pass cut off; the subwoofer’s

crossover should be bypassed. This is

the recommended option.

Wide The subwoofer includes a crossover.

To set peak-level limiting

The Max SPL or Bass limit parameter allows you to set up

peak-level limiting for bass signals, and the setting applies to all

the discrete digital DSP presets.

If your loudspeaker layout includes one or more subwoofers the

parameter is named Max SPL, and it sets the peak-level limit for

the LFE channel.
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To configure the source options

● Select the source in the list of sources.

● Click the Options tab.

● Select Source exists if you want to use this source.

This section describes how to use the Meridian Configuration

program to configure the sources provided by the digital

surround controller.

To set up sources

● Click the Sources icon in the left-hand panel of the Meridian

window.

The right-hand panel shows a list of the 12 sources that are

available. For each source you can display three pages of

settings by clicking on the Options, Connections, or Advanced

tabs.

Setting up sources
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● Click the Connections tab to show the Connections page of

settings.

● From the Main input drop-down menu specify the digital or

analogue audio input you want to use for the source.

● From the Video Input drop-down menu specify the video

input you want to use for the source.

You can prevent the source from appearing in the list of sources,

or being selectable using the Meridian System Remote, by

disabling this option.

● If you want, you can change the name displayed when the

source is selected by editing the Name field.

The name can consist of up to five letters, digits, or the

characters space, full-stop, and minus.

The name you specify is shown in the list of sources followed by

the Meridian System Remote key used to select the source in

brackets.

● In the Presets section specify the DSP preset you want to use

for each of the five alternative audio formats: PCM, AC-3,

MPEG, DTS, or MLP.

Each drop-down menu gives the built-in and user-defined DSP

presets appropriate for that audio format.
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Either option can be set to Last valid to leave the corresponding

setting unchanged when you select the source. You would

usually set Video Input to Last valid for audio sources such as

CD, Radio, Tape1, and Tape2.

You can create a source with Main input set to Last valid if you

want it to change some other aspect of the current source, such

as its DSP preset, without changing the selected input.

If you have specified a digital input for the main audio input:

● Specify the precision for the source by choosing an option

from the Precision drop-down menu.

All CDs and laserdiscs are currently 16-bits. The 518 provides

24-bits. If in doubt choose 24-bit.

The Extra analogue input drop-down menu allows you to select

an extra analogue input for copying digital sources. Select this if

your digital source also provides an analogue output, and you

want to make analogue recordings from it.

If you have chosen an analogue input for the main audio input:

● Specify the sensitivity of the input by choosing an appropriate

option from the Sensitivity drop-down menu.

Note that you can also adjust the sensitivity of any analogue

source interactively, using Gain/Sub mode. See To adjust the

sensitivity of analogue sources, page 76.
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can configure them to have different Comms addresses. You

can then select the appropriate source by specifying its

Comms address in the Comms address field.

● You can also select a 30 millisecond delay to avoid DTS

noise. This option should not be selected for video sources as

it will prevent the sound from being in sync with the picture.

● Select Only ever play DTS for this source to create a video

DTS source that will avoid any DTS noise when switching

audio formats.

● Select either of Triggers 1 or 2 to activate the specified

trigger outputs when this source is selected.

To set the advanced source options

● Click the Advanced tab to show the Advanced page of

settings.

● If the source is connected to another Meridian unit, set

Comms type to 1C for a Meridian CD player, 2C for a

Meridian FM tuner, and 3C for a Meridian DVD player.

Otherwise set it to none.
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Configuring presets

The 561 Digital Surround Controller provides 21 built-in presets

and the Meridian Configuration program lets you configure the

DSP parameters of any of the built-in presets to suit your own

preferences.

You can also create up to 12 additional user-defined presets.

Each user-defined preset is based on one of the built-in presets,

and can have any name of your choice.

To set up presets

● Click the Presets icon in the left-hand panel of the Meridian

window.

The right-hand panel shows a list of the 21 built-in presets, and

the 12 unused user-defined presets.

To modify a built-in preset

● Select the preset in the list of presets.

The default DSP parameters will be displayed:

● Adjust the parameters as required.
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built-in presets.

● Select the new preset you have created.

● Edit the preset name to identify the preset.

Initially the name is set to be the same as the built-in DSP preset it

was based on, but you can chose any name of up to 8 letters,

digits, or the characters space, full-stop, or minus; eg Football.

Note that the treble and bass settings will not be available if your

system includes DSP loudspeakers, because in this case the

DSP speakers handle the treble and bass adjustments.

For more information about the DSP parameters available for

each DSP preset see DSP presets, page 37.

If you have modified the DSP parameters from their defaults,

(modified) is displayed after the preset name in the list of

presets.

To restore the DSP parameters to
their defaults

● Select the preset in the list of presets.

● Click the Reset to default button.

To create a user-defined preset

● Select the preset you want to use as the basis for the user-

defined preset.

● Click the Copy as new preset button.
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To delete a user-defined preset

● Select the preset in the list of presets.

● Click the Delete this preset button.

To copy a preset to a specific position
in the list of user-defined presets

● Highlight the preset you want to copy.

● Choose Copy from the Edit menu, or click the

Copy button in the toolbar:

● Highlight the user-defined preset or empty position you want

to replace.

● Choose Paste from the Edit menu, or click

the Paste button in the toolbar:
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Setup options.

To change the setup options

● Click the Setup icon in the left-hand panel of the Meridian

window.

The Setup options will be displayed:

The options are described in the following table:

Option What it means

Lock settings on Locks the DSP preset parameters.

product

On-screen display Specifies the default position of the

position on-screen display.

Multi-room displays Includes displays of information from

Meridian sources; eg CD track number or

FM tuner frequency.

Diagnostic displays Includes diagnostic displays in the

display options.

Module type Selects an optional module, if fitted.

Fan Sets the fan operation, if fitted.

Volume on startup Specifies the volume selected on

switching on at the back panel.

Comms controller Specifies whether the 561 is controller,

status not controller, or set automatically.

System and Copy For multi-room setups.

address

Changing the setup options
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Once you have edited the settings to suit the configuration of

your system, the next step is to store the settings to the 561 and

use the calibration listening tests built into the 561 to calibrate it

for correct performance.

To save the settings

First save the settings to your PC hard disk.

● Choose Save from the File menu, or click the

Save button in the toolbar:

To print a summary of settings

At this stage it is useful to print a summary of the speaker and

source settings, so that you can check that they correspond to

your system configuration.

● Check that there is a printer connected to your PC.

● Click the Settings icon in the left-hand panel of the Meridian

window.

● Click the Print sources and output summary button.

To store the settings to the digital
surround controller

● Switch on the 561 Digital Surround Controller, and check that

the serial cable is connected between the 561 and the PC.

● Click the Store button in the toolbar.

The 561 will display:
Receiving...

The following Progress dialogue box shows how the operation

is progressing.

If there is a problem click the Details>> button to see more

information about the problem.

Calibrating the settings with your system
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itself to use the new settings, and show the owner name you

defined:

For example:
Zachary Ford

To calibrate the loudspeakers

Now proceed through the calibration procedure to set the

correct relative level, delay, and phase for each of the

loudspeakers in the system. See Calibrating the System,

page 69.

To adjust the sources

The second calibration stage involves adjusting the sensitivity of

the analogue sources; see To adjust the sensitivity of analogue

sources, page 76.

To fetch the calibrated settings

Finally fetch the calibrated settings back from the digital

surround controller as follows:

● Make sure your settings file is loaded into the Meridian

Configuration program.

● Click the Fetch button in the toolbar.

The Progress dialogue box will show you the progress as the

settings are fetched:

You can verify that the calibrations you made are now included

in the settings by checking the Distances and Phase/Gain

pages of the Speakers settings option.
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Creating a User Type

Once you have fetched the calibrated settings from the digital

surround controller, the final step is to store them permanently

to the 561 as a User Type, so that you can reset the unit to them

whenever you need to.

When you store one or more User Types to the 561 they

become available in the list of Types, alongside the built-in

Types. For more information about selecting one of the Types

see Choosing a standard setting, page 66.

To name the User Type

● Click the Settings icon in the left-hand panel of the Meridian

window:

● Enter a suitable name in the Type name field to identify your

User Type, such as Standard.

The name can have up to 12 characters.
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If you wish you can create several User Types, and store them

all to the digital surround controller. You can then reset the

digital surround controller to any of the User Types by selecting

the appropriate Type name.

To create a new User Type:

● Select the User Type you want to base it on in the left-hand

panel of the Meridian Setup window; eg Standard.

● Click the Copy as new user type button.

● Select In use if you want the User Type to be selected

automatically when you store it to the digital surround

controller.

Initially the new type will be created with the same settings as

the type you based it on, and with the name New type:

You can then change the name of the new Type, and configure

its settings, in exactly the same way as for the original Type.

A suggested naming convention is to name User Types with the

date they were created: for example, 06/05/98.
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To copy settings between User Types

● Highlight the User Type you want to copy the settings from.

● Choose Copy from the Edit menu, or click

the Copy button in the toolbar:

● Highlight the User Type you want to copy the settings to.

● Choose Paste from the Edit menu, or click the

Paste button in the toolbar:

You can also copy and paste source and preset settings from

one section of a user type to the same section of another user

type as follows:

● Highlight the icon corresponding to the section of settings you

want to copy: Sources or Presets.

● Choose Copy from the Edit menu, or click the

Copy button in the toolbar:

● Highlight the same icon in the User Type you want to copy to.

● Choose Paste from the Edit menu, or click the

Paste button in the toolbar:
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Completing the configuration

The final stage in creating a settings file is to save it, and then

store it to the digital surround controller.

To save the current settings

● Choose Save from the File menu or click the Save toolbar

button, to save the changes you have made to the

settings file to your PC hard disk.

To store the settings to the 561 Digital
Surround Controller

● Click the Store button.

The settings will then be downloaded

to the 561. The 561 will display:
Receiving...

As the download proceeds the following dialogue box shows its

progress:

If the download was successful the 561 will briefly display the

owner name you have defined;

For example:
Zachary Ford

It will then switch itself to standby.

The User Type you have created will now be available in addition

to the built-in Types, and will be selected by default if you need

to reset the configuration of the digital surround controller; see

Choosing a standard setting, page 66.
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Troubleshooting

This chapter provides suggested solutions to typical problems that may

occur when setting up the digital surround processor.

If you are still not able to resolve a difficulty with the help of this guide and

the suggestions in the following pages, please contact your Meridian

dealer or Meridian Audio Ltd.
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Standby point not lit

Check the following:

❍ There is AC power connected to the socket on the rear of the

561.

❍ The power switch on the rear panel of the 561 is turned on.

If the 561 will still not illuminate, check any fuses in your power

supply and the fuse in the inlet of the 561. If these are all intact,

contact your dealer.

Erratic or unexpected system
behaviour

Redo the Auto Configure process as follows:

❍ Put the whole system into standby.

❍ Press Clear on the Meridian System Remote.

❍ Observe all units responding correctly.

If this fails, the memory of the 561 may have been corrupted. If

this is suspected perform a full reset; see Choosing a standard

setting, page 66.

Remote not working

Check the following:

❍ The battery in the Meridian System Remote.

❍ Remove the 500 Comms connections from the 561, does it

respond now? If so, replace the connections and perform an

Auto Configure procedure as described opposite.

❍ See if the 561 has been set up as not controller in the

Meridian Configuration program; see Changing the setup

options, page 98. Note that this may be deliberate by your

dealer.

General operating problems
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When playing a Dolby Digital DVD, the
561 selects the Pro Logic preset

DVDs include a two-channel Dolby Digital soundtrack, which will

use the default two-channel preset.

❍ Select a six-channel soundtrack, if it is available.

Unit is overheating

If there is not adequate ventilation around the unit, or you are

operating it in an enclosed space, you will need to fit the

optional Fan kit.
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Hum on analogue input

There is no reason for the 561 to produce hum on the analogue

input.

❍ Check the source equipment. Disconnect each source in turn.

❍ If the hum originates from a ground loop, an antenna or cable

supply may be the cause. In this case an antenna-lead isolator

should be fitted.

❍ If the 561 seems to be the cause of hum consult your dealer.

Poor sound quality

Poor sound quality will usually result from driving an analogue

input too hard.

❍ Turn down the analogue input level.

❍ To optimise this use Gain/Sub mode; see To adjust the

sensitivity of analogue sources, page 76.

There is radio interference

The 561 is a digital audio and computing device which has been

designed to very high standards of electromagnetic

compatibility.

If this equipment does cause or suffer from interference to/from

radio or television reception then the following measures should

be tried:

❍ Reorient the receiving aerial (or antenna) or route the antenna

cable of the receiver as far as possible from the 561 and its

cabling.

❍ Ensure that the receiver uses well-screened antenna cable.

❍ Relocate the receiver with respect to the 561.

❍ Connect the receiver and this product to different AC outlets.

❍ If the problem persists contact your dealer.

Audio problems
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Audible hiss at high volume settings

The input dynamic range of most current recordings is at

maximum 16 bit. The reason for this is that currently CD, DVD,

and LaserDisc use a 16-bit standard although DVD can support

up to 24-bits. The analogue sources you have cannot achieve

this kind of range. For comparison, analogue sources are likely

to be of the order of:

❍ VCR, 12 bits.

❍ FM radio, 13 bits.

❍ Reel to reel tape, 13 bits.

❍ Cassette tape, 12 bits.

❍ LP, 11 bits.

Note that there may be a difference between the dynamic range

of the source channel when it is operating, and the noise you

hear in standby. For example, LP normally has lower noise when

the stylus is not in the groove; similarly tape will be quieter when

it is stopped. CD may also be quieter when it is stopped,

producing so called ‘digital silence’.

The 561 has a 20-bit capability on its internal analogue-to-digital

converter, which is used for analogue sources. When the volume

is turned up high you may hear its dither as a hiss when the

sources are stopped. This hiss is lower than the background

noise of your recordings and should be of no consequence.

The 561 has 20-bit output precision on the analogue outputs.

Other sources of hiss may be tracked down using the Mute

option. When muted the outputs are reduced to the dither at the

selected precision.

Crackling on optical inputs

Some optical sources, in particular some LaserDisc players,

provide poor drive waveforms that do not meet the EIAJ

standard. This is because the light modulates but never goes

quite ‘black’ between pulses. If you experience crackling on the

optical input or an occasional reluctance to lock, ie provide a

sound, investigate as follows.

❍ Try other fibres.

❍ Pull the fibre part-way out and see if the problem clears up.

❍ Try another player or CD player on the optical input.

❍ Contact Meridian for up-to-date advice on this point.
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Sound not clear

❍ If speech sounds muffled in a system with a centre speaker,

check that sound is coming from the centre as there may be a

connection problem. In a digital or Meridian feed to the centre

you may have set it up to be right instead of left so that it is

playing a subwoofer signal.

❍ If speech sounds muffled in a system with no centre speaker,

you may have selected a layout that expects one. See To

specify the speaker layout, page 86.

Centre not working

There may be a connection problem.

❍ In a digital or Meridian feed to the centre, you may have set it

up to be right instead of left, and therefore it may be playing a

subwoofer signal.

There is a hiss when starting DTS
LaserDiscs

The DTS audio stream is indistinguishable from a PCM audio

stream; the 561 takes 30ms to identify the encoding, during

which a hiss is heard.

❍ With non-video DTS sources you can add a 30ms delay to

avoid this.

❍ With video sources you can create a DTS-only source to avoid

any hiss.
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Poor picture quality

Picture quality may suffer if you do not attend to the following:

❍ Are you using suitable quality cables with good connectors?

❍ Is there a ground loop created between any of the

components connected to the 561?

Remember that reception of broadcast or cable signals can be

significantly deteriorated by cross-modulation in the RF domain.

It is unwise to attempt to cascade and mix several video

sources, eg LaserDisc, VCR, etc, to an antenna system.

Video problems

Video source produces a ‘washed out’
low-contrast image

The 561 video inputs V1 to V3 and S1 to S3 are direct coupled,

for highest quality. However, some video sources (typically cable

television interfaces) have a DC offset which causes video

problems. In this case use V4 or S4, which provide DC rejection.
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Meridian Configuration program problems

Preset options do not appear or are
not available

The options available when you are editing the DSP preset

parameters depend on the speaker layout you have defined in

Speakers.

❍ If you have any DSP speakers in the layout, treble and bass

are not available.

❍ The Speakers options for Centre, Sides, and Rears can only

be edited if your layout includes the corresponding speakers.

Meridian Configuration program
repeatedly fails to talk to the product

❍ Check that you have selected a COM port.

❍ Check that no other program currently running is using the

COM port.

❍ Check that it is connected correctly.

❍ Turn off the 561 for a few seconds and turn back on, then

retry.

❍ Quit from all other programs and retry.

❍ Reboot the computer and retry.

❍ Ensure you are using the serial lead supplied with the product,

or a null modem cable.

❍ If you are using a laptop try turning off the screensaver or

power management software.
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Service

The Meridian 500 Series of hi-fi components have been carefully

designed to give years of untroubled service. There are no user-

serviceable parts inside the case, nor do the units require any

form of maintenance.

In the unlikely event that your 561 fails to function correctly, it

should be returned, in its original packaging, to your Meridian

dealer.

In case of difficulty within the UK or USA please contact the

appropriate sales and service address shown on page ii.

In case of difficulty outside the UK or USA, contact the importing

agent for the territory. A list of Meridian agents abroad is

available from Meridian Audio.

No responsibility can be accepted for the 561 whilst in transit to

the factory or an agent, and customers are therefore advised to

insure the unit. When seeking service under guarantee, proof of

the date of purchase will be required.

Service and guarantee

Guarantee

The 561 Digital Surround Processor is guaranteed against

defects in material and workmanship for 2 years from the date of

purchase.

The guarantee is void if the 561 Digital Surround Processor has

been subject to misuse, accident, or negligence, or has been

tampered with or modified in any way without the written

authorisation of Meridian Audio Limited. Note that connecting

anything other than the correct network lead to the COMMS

sockets may cause damage to the 561 Digital Surround

Processor which will not be covered by this guarantee.

Attempted servicing by unauthorised people may also invalidate

this guarantee. Labour and carriage charges are not covered

unless by local agreement.

Outside the UK, local warranty liability is restricted to equipment

purchased within the territory. Our agents abroad are only under

contractual obligation to service under guarantee equipment

sold through them. They are entitled to make a non-refundable

charge for any service carried out on other equipment.

This guarantee does not limit your statutory rights within the

United Kingdom.
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Glossary

Absolute phase

A control which changes the phase of the

signals to all the speakers.

AC-3

An alternative name for the Dolby Digital

format.

Ambisonic

A music encoding and decoding system

designed to recreate the original

soundfield using an array of loudspeakers.

Aspect ratio

The overall shape of the speaker layout.

Compress

A DSP parameter providing dynamic range

control for Dolby Digital sources.

Controller

The product in a Meridian system that

uses the infra-red signals from the remote

to control the system. The controller is

normally chosen automatically, but the

installer can override this.

Dolby Digital

A digital surround-sound which provides

five full-frequency range channels (left,

centre, right, left surround, and right

surround) and an additional Low

Frequency Effects (LFE) channel which is

band limited to 120Hz.

Dolby Surround

The encoding system used for the majority

of movies on video and many TV

broadcasts. Dolby Surround encoded

material can be replayed with a surround

decoder connected to an array of

loudspeakers which normally include at

least left, centre, right, and rear surround.

DTS

Digital Theatre Systems originally

produced digital audio tracks for motion

pictures. A version of this format adapted

for consumer video and audio products is

referred to as DTS Entertainment. Like

Dolby Digital it provides five full-frequency

range channels (left, centre, right, left

surround, and right surround) and an

additional Low Frequency Effects (LFE)

channel.

DVD

Digital Video Disc or Digital Versatile Disc,

a CD-sized disc with nearly 30 times the

storage capacity of CD. It is capable of

storing digital video, high-quality multi-

channel audio, or computer data.
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Layout

Refers to a particular arrangement of

speakers and subwoofers. You can select

different layouts for the cinema, music,

and 5.1 DSP presets.

LFE

The Low Frequency Effects (LFE) channel

which enhances movie soundtracks with

sound effects and ambient sounds. It is

band limited to 120Hz in a Dolby Digital

system.

LFE sub

A subwoofer which plays the full 120Hz

bandwidth LFE signal in Dolby Digital,

DTS, and MPEG presets.

Limit

A DSP parameter that sets the peak-level

limit of the bass signal added to the main

loudspeakers.

Max SPL

A DSP parameter that sets the peak-level

limit for the LFE channel.

Menus

The flexible system for choosing options

and configuring settings in Meridian

products. On the 561 the menus are

controlled by the <, >, A, and V keys on

the MSR.

MLP

MLP (Meridian Lossless Packing) is an

audio format that increases the amount of

information that can be recorded on a CD

or DVD, without any loss of quality.

Mono sub

A subwoofer which handles all the bass for

the system. A THX standard subwoofer

has a crossover at 80Hz.

Mono surrounds

Surrounds which have a common signal

steered to them. This may then be

decorrelated by the THX process to give

more spaciousness.

MPEG

MPEG Surround is a digital encoding

system developed by the Motion Picture

Expert Group. Like Dolby Digital it

provides five full-frequency range

channels and an additional Low Frequency

Effects (LFE) channel.
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MSF

Meridian Settings File, a file containing

settings and User Types for one or more

Meridian products.

MSR

The Meridian System Remote, or handset.

OSD

On-Screen Display, which the 561 can

superimpose on a composite video signal

to give information about the state of the

system, and to help during configuration.

PCM

Pulse Code Modulation, the method used

to encode music digitally, as used on

audio CDs.

Preset

A DSP decoding option in the 561. You

can create user-defined presets based on

the built-in presets, and with specific

parameter values; see Defining your own

presets, page 34.

Source

An input to the system, such as CD or TV.

The Meridian 500 and 800 Series provide

12 named sources, corresponding to the

names of the 12 source keys on the MSR.

In the 561 you can choose the logo

displayed for each source, and the input

used for it.

Special sub

A subwoofer option that gives no

subwoofer for Music DSP presets, a

centre subwoofer for Logic presets, and

an LFE subwoofer for 5.1 Movie presets.

SPL

Sound Pressure Level, a physical

measurement of the level of sound at a

particular location which can be obtained

using an SPL meter.

Steered surrounds

Surrounds which have individual signals

steered to them by the digital surround

processor’s steering matrix.

Surround

A sound reproducing system with more

than two loudspeakers, and usually with

speakers behind or to the side of the

listener.
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THX

Additional processing that follows Dolby

Pro Logic Surround decoding to give a

more faithful reproduction of cinema

sound in the home.

Trifield

A music decoding system designed to

extract centre and surround signals from a

conventional two-channel stereo source.

Type

A standard configuration of the digital

surround controller. Selecting a Type

resets any configuration and calibration

changes.
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Index

A AC-3 encoding 8

Academy DSP preset 11, 40

Accessories 6

expansion cards 6

Fan kit 7, 50

Meridian 511 S-patch Box 6

Meridian 519 Demodulator 7

Rack mount kit 7

Tape card 6, 22

Active loudspeakers,

connecting 58

Active subwoofer, connecting 59

Ambisonic DSP preset 10, 43

Ambisonic encoding 10

Analogue recorder, connecting 62

Analogue sources

adjusting sensitivity 76

connecting 60

Audio formats 20, 41

Dolby Digital 8, 20

DTS 8, 20

MLP 9, 20

MPEG 9, 20

two-channel (PCM) 9, 20

Audio inputs, digital 52

Audio outputs 53

Audio problems 108

Audio stream display 21

Audio tape outputs 54

Automatic setup 64

B Balance (DSP

parameter) 25, 26, 28

Bass (DSP parameter) 26, 27

Bass, changing 27

built-in presets, changing 34

C Calibrating the system 69

Calibration procedure

exiting from 71

starting 70

Calibration tests 72

Distance 73

Fine tuning 74

Levels 72

moving between 71

Centre (DSP

parameter) 26, 30, 42

Centre speaker

changing the relative delay 30

changing the relative level 30

not working 110

Clearing a DSP preset 36

Clip indicator 77

Clipping of analogue sources 76

Communications connections 55

Components 50

Compress (DSP parameter) 47

Compression 47

Computer, configuring using 79

Configuring the digital surround

controller

using a computer 79

without a computer 65

Control outputs 54

Controller, setting 64

Copy options 22

Copying a source 22

Copying settings between user

types 103

Crackling on optical inputs 109

Crossover frequency, adjusting 77
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D Defining your own presets 23, 34

Depth (DSP parameter) 25, 26, 30

Digital audio inputs 52

Digital DSP preset 8

Digital recorder, connecting 62

Digital source, connecting 60

Direct DSP preset 11, 45

Display

changing 21

options 21

Distance calibration test 73

Distance units, changing 70

Dolby Digital DSP preset 46

dynamic range control 47

Dolby Digital encoding 8

Dolby Digital THX DSP

preset 9, 46

Dolby Surround encoding 9

DSP loudspeakers. See Meridian

DSP loudspeakers

DSP parameters

Balance 25, 26, 28

Bass 26, 27

Centre 26, 30, 42

changing 25

DSP parameters (continued)

Compress 47

Depth 25, 26, 30

Input 40

LFE 47

Limit 47, 48

LipSync 26, 32

Max SPL 47, 48

Mono Rear 39, 40, 44

OSD 26, 32

Phase 26, 27

Position 44

R Delay 26

R Filter 44

Rear 26, 29

Roll 40, 44

S Delay 26

S Filter 44

saving 34

Sides 26, 29

Surr. Rear 47

Treble 26, 27

Width 42, 44

Yaw 40, 44

DSP presets 8, 37

Academy 11, 40

Ambisonic 10, 43

changing 20

changing source association 33

clearing 36

configuring using a PC 95

defining 23, 34

Direct 11, 45

Dolby Digital 8, 46

Dolby Digital THX 9, 46

DTS 8, 46

DTS Music 9, 45

DTS THX 9, 46

editing name 34

MLP 9, 45

modifying a built-in preset

using a PC 95

Mono 11, 40

MPEG 9, 46

MPEG Music 9, 45

MPEG THX 9, 46

Music 10, 41

Music Logic 11, 44

Pro Logic 9, 38, 39
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DSP presets (continued)

Stereo 11, 45

Super Stereo 11, 43

THX Cinema 10

Trifield 11, 41

TV Logic 10, 39

DTS DSP preset 8, 46

DTS encoding 8, 9

DTS Music DSP preset 9, 45

DTS THX DSP preset 9, 46

DVD player, connecting 61

Dynamic range control 47

E Expansion cards 6

Expansion socket output 54

F Fan kit 7, 50

Fetching calibrated settings 100

Fine tuning calibration test 74

5.1 Movie DSP presets 46

Front panel

controls 14

display symbols 21

G Gain/Sub mode 76

Glossary 115

H Headphone volume 22

Hiss

at high volume settings 109

starting DTS LaserDiscs 110

Hum on analogue input 108

I Input (DSP parameter) 40

Installing the Meridian

Configuration program 81

Integration of the centre,

changing 30

Introduction 1

L LaserDisc player, connecting 61

Levels calibration test 72

LFE (DSP parameter) 47

Limit (DSP parameter) 47, 48

Lip sync, changing 32

LipSync (DSP parameter) 26, 32

Listening position, moving to the

left or right 28

Locking the menus 24

Logic DSP presets 38

Loudspeakers

connecting 57

setting up using a PC 86

specifying layout using a PC 86

specifying the size and type using a

PC 87

specifying the sizes using a PC 89

Low-contrast image 111

M Max SPL (DSP parameter) 47, 48

Menus, locking and unlocking 24

Meridian 500 Series 2

communications 2

DSP5000 Digital Loudspeakers 4

M1500 Active Subwoofer 3

M33 Active Analogue

Loudspeaker 3, 4

Meridian 500 Series operation,

setting 64

Meridian 511 S-patch Box 6

Meridian 519 Demodulator 7

Meridian Analogue Theatre 3

Meridian comms 55, 64
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Meridian Configuration

program 80

installation 81

problems 112

requirements 81

running 82

toolbar buttons 82

Meridian Digital Theatre 4

Meridian DSP loudspeakers

connecting 53, 57

using as

controller 16, 20, 25, 33, 35

using with remote control 25

Meridian Lossless Packing 9, 45

Meridian System Remote

front panel controls 15

quick guide 16

MLP DSP preset 9, 45

Monitor, connecting 56

Mono DSP preset 11, 40

Mono Rear (DSP

parameter) 39, 40, 44

MPEG DSP preset 9, 46

MPEG Music DSP preset 9, 45

MPEG Surround encoding 9

MPEG THX DSP preset 9, 46

Music DSP preset 10, 41

Music Logic DSP preset 11, 44

Muting the sound 19

N New (File menu) 84

O On-screen display (OSD) 21

changing position 32

Optical input 52

Options (View menu) 83

Options dialogue box 83

OSD (DSP parameter) 26, 32

Overheating problems 107

Owner icon 84, 85

P PC, using to configure the 561 79

Peak-level limiting 48, 90

Personal details, entering using a

PC 85

Phase (DSP parameter) 26, 27

Phase, changing 27

Poor picture quality 111

Poor sound quality 108

Position (DSP parameter) 44

Positioning 50

Presets icon 80, 95

Pro Logic DSP preset 9, 38, 39

Pro Logic encoding 9

R R Delay (DSP parameter) 26

R Filter (DSP parameter) 42, 44

Rack mount kit 7

Radio interference 50, 108

Rear (DSP parameter) 26

Rear loudspeakers

changing the relative delay 31

changing the relative level 29

Rear panel 51

Recording

a source 22

from a television 22

Remote 15

quick guide 16

troubleshooting 106

Restoring the sound 19

Return to top level icon 84

Roll (DSP parameter) 40, 44

Room resonances, checking

for 78
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S S Delay (DSP parameter) 26

S Filter (DSP parameter) 42, 44

S-patch Box 6

Sample configurations

Meridian Analogue Theatre 3

Meridian Digital Theatre 4

Save As (File menu) 84

Selecting a source 17

Serial cable, connecting 83

Serial port, specifying 83

Setting up

loudspeakers 86

sources 76

the Digital Surround Controller 49

Settings file, creating 84

Settings icon 84, 85

Setup icon 80, 98

Setup options, using a PC 98

Side loudspeakers

changing the relative delay 31

changing the relative level 29

Sides (DSP parameter) 26, 29

Sinewave sweep test 78

SizeCalc 89

Sound not clear 110

Sound Pressure Level meter 69

Sources 17

adjusting sensitivity 76

changing DSP preset associated

with 33

configuring options using a PC 91

connecting 60

recording 22

selecting 17

setting advanced options using

a PC 94

setting up 76

setting up using a PC 91

specifying connections using a

PC 92

standard settings 68

Sources icon 80, 91

Spaciousness of the sound,

changing 31

Speakers

connecting 57

setting up using a PC 86

specifying layout using a PC 86

specifying sizes using a PC 89

Speakers (continued)

specifying the size and type using

a PC 87

Speakers icon 80

Special sub option 66

Specification 5

Standard settings 66

choosing 67

Standard source settings 68

Standby

switching on from 17

switching to 18

Stereo DSP preset 11, 45

Stereo power amplifier,

connecting 58

Storing settings 99

Subwoofers

crossover 59

setting crossover frequency 77, 78

Super Stereo DSP preset 11, 43

Super Stereo encoding 11

Surr. Rear (DSP parameter) 42, 47

Switching on from standby 17

Switching to standby 18
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T Tape card 6, 22

Tape outputs 54

Tape recorder, connecting 62

Television

connecting 56

recording from 22

THX Cinema DSP preset 10

THX encoding 10

THX reference gain 19

Toolbar buttons 82

Treble (DSP parameter) 26, 27

Treble, changing 27

Trifield DSP preset 11, 41

Troubleshooting 105

audio 108

general operation 106

Meridian Configuration program 112

video 111

TV Logic DSP preset 10, 39

Types 66

choosing 67

standard 68

U UHJ format 43

Unlocking the menus 24

Unpacking 50

User Types

copying settings between 103

creating 101

naming 101

User-defined presets

creating 96

deleting 97

editing name 34

Using the Digital Surround

Controller 13

V Ventilation 50

Video

connecting 56

inputs 51

outputs 52

problems 111

Video recorder, connecting 63

Volume

adjusting 19

headphone 22

muting 19

W Width (DSP parameter) 42, 44

Y Yaw (DSP parameter) 40, 44
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